\o‘p"'\ WP-8000-CE7 Series

@P&é User Manual

V1.0.2, September 2020

WP-8121-CE7/WP-8421-CE7/WP-8821-CE7

Written by Sean Hsu
Edited by Anna Huang



Warranty

All products manufactured by ICP DAS are under warranty regarding
defective materials for a period of one year, beginning from the date of

delivery to the original purchaser.

Warning

ICP DAS assumes no liability for any damage resulting from the use of this
product. ICP DAS reserves the right to change this manual at any time
without notice. The information furnished by ICP DAS is believed to be
accurate and reliable. However, no responsibility is assumed by ICP DAS for
its use, not for any infringements of patents or other rights of third parties

resulting from its use.

Copyright

Copyright @ 2020 by ICP DAS Co., Ltd. All rights are reserved.

Trademark

The names used for identification only may be registered trademarks of

their respective companies.

Contact US
If you have any problem, please feel free to contact us.

You can count on us for quick response.

Email: service@icpdas.com
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1. Introduction

This chapter provides an overview of the WP-8000-CE7 and its components, and introduces the

fundamental concepts for user familiar with the WP-8000-CE7.

The WP-8000-CE7 is the new generation Windows CE 7.0 based PAC (Programmable Automation
Controller) of ICP DAS. Each WP-8000-CE7 is equipped with a Cortex-A8 (1.0 GHz) CPU running a
Windows CE 7.0 operating system, a variant of input/output ports (VGA, USB, Ethernet,
RS-232/485), and 1/4/8 expansion I/O slots that can be used to integrate high performance I-8K
(parallel-type) and 1-87K (serial-type) series |/O modules.

Its operating system, Windows CE 7.0, has many advantages, including hard real-time capability,
small core size, fast boot speed, interrupt handling at a deeper level, achievable deterministic
control and low cost. Using Windows CE 7.0 in the WP-8000-CE7 gives it the ability to run PC-based
Control software such as Visual Basic.NET, Visual C#, Visual C++, SCADA software, Soft PLC and etc.
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1.1. Features

The WP-8000-CE7 offers the most comprehensive configuration to meet specific application
requirements. The following list shows the hardware and software features designed to simplify

installation, configuration and application.

Hardware Features

J Powerful CPU module
o Cortex-A8 1.0 GHz CPU

. Memory Size:
- SDRAM (512 MB)
- Flash (256 MB)
- microSD card (support up to 32 GB)

* VGAPortx 1, USB 2.0 port x 2, Serial port (RS-232/RS-485) x 4
*  64-bit Hardware Serial Number

*  Dual Watchdog Timers

e Dual Ethernet Ports (10 M/100 M/1000 M)

*  Redundant Power Input

. Operating Temperature: -25~ +75 °C

Software Features

*  Windows Embedded Compact 7.0
*  JavaScript and VBScript

*  SQL Compact Edition 3.5

*  .NET Compact Framework 3.5

*  Remote Display

J Rich Software Solution — SDK for Microsoft Visual Studio 2008
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1.2. Specifications

The table below summarizes the specifications of the WP-8000-CE7.

Models

WP-8121-CE7 WP-8421-CE7 WP-8821-CE7

0S

Windows CE 7.0

.Net Compact Framework

3.5

Embedded Service

FTP Server, Web Server (Supports VB script, JAVA script),
Embedded SQL Server

SDK Provided

DIl for VC, DIl for Visual Studio.Net 2008

Multilanguage Support

CPU Module

English, German, French, Spanish, Russian, Italian, Korean,

Simplified Chinese, Traditional Chinese

CPU Cortex-A8 (1.0 GHz)

SDRAM 512 MB (DDR3)

Flash 256 MB

MRAM 128 KB

EEPROM 16 KB

microSD microSD socket with one microSD card

RTC (Real Time Clock)

Provide second, minute, hour, date, day of week, month, year

64-bit Hardware Serial Number

Yes, for software copy protection

Dual Watchdog Timers

Yes (0.8 second)

VGA & Communication Ports

VGA Resolution

Programmable LED Indicator 1
Rotary Switch Yes (0~ 9)
DIP Switch - Yes (8 bits)

800 x 600, 1024 x 768

Dual Ethernet Ports

RJ-45, 10 M/100 M/1000 M Base-TX

USB USB2.0x2
Internal communication with the high profile I-87K series
coOM 0
modules in slots
com1 RS-232 (RxD, TxD and GND); Non-isolation
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Models WP-8121-CE7 WP-8421-CE7 WP-8821-CE7

VGA & Communication Ports

COM 2 RS-485 (Data+, Data-);self-tuner ASIC inside; 3000 Vp isolated

RS-232/485 (RxD, TxD, CTS, RTS and GND for
COM 3 - RS-232; Data+, Data- for RS-485);
Non-isolation

RS-232 (RXD, TXD, CTS, RTS, DSR, DTR, CD, RI
and GND); Non-isolation

Number of 1/0O slots 1 4 8

COM 4 -

Dimensions (W x H x D) 95x132x111 231x132x111 355x132x 111

Installation DIN-Rail or Wall Mounting

Environmental

Operating Temperature -25°C~+75°C

Storage Temperature -30°C~+80°C

Ambient Relative )
10 % ~ 90 % RH (non-condensing)

Humidity

Environmental

Input Range +10 Vpc ™~ +30 Vpc
Redundant Power Inputs Yes
Isolation 1kVv

1.0A, 5V supply to 1.1A, 5V supply to 1.2A, 5V supply to
CPU and backplane, | CPU and backplane, | CPU and backplane,

Capacity 0.6A, 5V supply to 4.9A, 5V supply to 4.8A, 5V supply to
I/0O expansion slots, | 1/O expansion slots, | |/O expansion slots,
total 8 W total 30 W total 30 W
) 73W(03A@24 9.1W (0.38A@ 24 9.6 W (0.4A @24
Consumption
Vi) Vi) Vc)
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1.3. Overview
Here is an overview of the components and its descriptions.

WP-8121-CE7
Operating Modes Selector 1 Slot
Power Indicator —l

COM2: RS-485
COMi: RS-232 — =¥

Relay Output ——ze

Redundant Power —l:
Frame Ground —3¢

Ethernet Ports
HeEEors VGA Port
WP-8421-CE7
Operating Modes Selector microSD Socket COM4: RS-232

Power Indicator

COM3: WP-8421

RS-232/RS-485 — mm®

Relay Output
COM2: RS-485

Frame Ground
Ethernet Ports

USB Ports

VGA Port 4 1/0O Slots DIP switch
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WP-8821-CE7

Opearting Modes Selector microSD Socket COM4: RS-232
Power Indicator
o

COM3:
RS-232/RS-485

COM1: RS-232

USB Ports

VGA Port 8 I/O Slots DIP switch

The details of these items are as follows:

LED Indicators

Each WP-8000-CE7 has 2 system LED indicators that display the status of the system and power,
the meaning of these statuses are as follows as follows:

LED Indicator Label State (Color) Meaning

PWR LED Indicator PWR Green Power 1 is on
System/Programmable  LED RUN Orange OS is running

indicator - Programmable LED indicators

Operating mode Selector

Rotary Switch is an operating mode selector. The WP-8000-CE7 has several operating

modes, for more detailed information about these operating mode, please refer to “2.4

Configuring the Boot Mode”
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Redundant Power (PWR1 and PWR2) and relay output

The WP-8121-CE7/WP-8421-CE7/WP-8821-CE7 has a terminal with 12-wire/9-wire/9-wore; there
are 4-wire for redundant power inputs and 2-wire for relay output, the details of the redundant
power and relay output are shown to the side.

WP-8121-CE7 WP-8421-CE7
WP-8821-CE7

% % EﬁEE:PowerInput 1
% % EﬁEE:PowerInputz
% LR.NO = % EEEM: Relay Output
=) -R.CDM- Relay Output =4 )
= rP-GND ™ Power In =

put 2
EQ| [PwR2 - =
= rP-GND = Power In

put 1
= ~PWR1 =
=

e Redundant Power

The WP-8000-CE7 provides redundant power that can keep the device running if a problem

occurs in the power supply.

e Relay Output

The WP-8000-CE7 has a relay output that can be used to control a light, siren, or other low

voltage device when an alarm occurs.

Relay Output >
AN :
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Communication Ports

The WP-8000-CE7 Series modules are equipped with several interfaces and peripherals that can be
integrated with external systems.

e VGA Port

The VGA connector is a 3-row 15-pin connector that can be used to connect a
monitor at a variety of supported VGA resolutions. and the output resolution
covers, 800 x 600, 1024 x768.

e Ethernet Ports (LAN1 and LAN2)

The WP-8000-CE7 has two Ethernet ports that can be used to connect the router to the Internet

or to other devices.

Each Ethernet port has two LED indicators, which are used to indicate the network speed and

Link/Acting, as described below.

ON (Orange) Network Speed: 1000 MB GB

OFF Network Speed: 10/100 MB
Link/Act ON (Green) The Link is active

OFF The Link is inactive

Blinking(Green) | Network activity

e USB Ports (P1 and P2)

The WP-8000-CE7 has two USB 2.0 ports that can be used to connect the USB devices such as

mouse, keyboard or an external USB hard drive.

e microSD Socket

The microSD socket comes with a free microSD card that can be used to restore the system, and

expand the memory up to 32 GB.
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e COMO, Expansion 1/0 Slot

The WP-8000-CE7 has 1/4/8 1/0 slots that can be used to integrate high performance parallel
I/0 modules (high profile I-8K Series) or serial I/O modules (high profile I-87K series).

e COM1 (3-wire RS-232, for WP-8121-CE7 only)

Note: 16C550 compatible L GND
-RxD
LTxD

Port Type: Female

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps
Data Bits: 7,8

Parity: None, Even, Odd

Stop Bits: 1

FIFO: 64 byte

)0 ) m mf mm

e COM1 (RS-232, for WP-8421-CE7 and WP-8821-CE7 only)

The COM1 port is a 9-pins RS-232 connector. The details of the COM1 port specifications are
shown to the side.

Note: 16C550 compatible

Port Type: Female

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps

Data Bits: 7,8

Parity: None, Even, Odd

Stop Bits: 1
FIFO: 64 byte
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e COM2 (2-wire RS-485)

WP-8121-CE7
Note: 16C550 compatible = D-
Port Type: Terminals I=]| [FD+
Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, % WP-8421-CE7
2400, 1200 bps = WP-8821-CE7
Data Bits: 5, 6, 7, 8 % %
Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) = =
: =y =
Stop Bits: 1, 2 = =
FIFO: 128 bytes % % LD+
0| o
=

e COM3 (RS-232/RS-485, for WP-8421-CE7 and WP-8821-CE7 only)

The COMS3 port is a 9-pins RS-232/RS-485 connector. The details of the COM3 port specifications
are shown to the side.

Note: 16C550 compatible
Port Type: Male GNDHG) Dl oata
Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps @ (®-1+RTS
RxDIHS @H+CTS
Data Bits: 5, 6, 7, 8 TxD1H2 ®
Data+-+H1)
Parity: None, Even, Odd, Mark (Always 1), Space (Always 0)
.
Stop Bits: 1, 2
FIFO: 128 bytes
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e COM4 (RS-232, for WP-8421-CE7 and WP-8821-CE7 only)

The COM4 port is a 9-pins RS-232 connector. The details of the COM4 port specifications are
shown to the side.

Note: 16C550 compatible

Port Type: Male %Iflrg\: 8 (9HTRI
Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 1 XP® g jﬁIﬁ
Data Bits: 5, 6,7, 8 gé[[)):% @DSR
Parity: None, Even, Odd, Mark (Always 1), Space (Always 0)

Stop Bits: 1, 2
FIFO: 128 bytes

Tips & Warnings

The table below shows the data bit and their corresponding stop bit for
COM1, COM2, COM3 and COM4.

Word Length ‘ Number of Stop Bits
56,7,8 | 1
5 1.5
6,7,8 2

e DIP Switch

The DIP switch can be used to set the Module ID to a number from 0 to 255.
Do not use Module ID 0 for communication.
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1.4. Dimensions

The diagrams below provide the dimensions of the WP-8000-CE7 to use in defining your enclosure
specifications. Remember to leave room for potential expansion if you are using other components

in your system.

The height dimension is the same for all WP-8000-CE7. The width depending on your choose of I/0

expansion slots. All dimensions are in millimeters.

WP-8121-CE7

122.0
132.0

WP-8421-CE7

Y

[
=
o

w
~
[a%]

(=]

& - 7 -

f'
L]
Sk

a1

\ ]| ST
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WP-8821-CE7
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1.5. Companion CD

This package comes with a CD that provides a collection of the software utility, documentation,
drivers, demo program and application. The CD contains several subdirectories located in \wp-8x2x
directory. All of them are listed below.

CD:\WinPAC_AM335x\wp-8x2x\

Backup

- —

The files package for each release.

- —

The demo programs for examples of use in the application.

The technical support documents for installation, operation,

maintenance, development and application.

I

The recovered files stored on the micro SD card, that can be used to
boot and recover the system from micro SD card.

OS_image

1

The files and related information for OS releases and technology.

”a

The tools and utilies for operation with PC.

1

The sources for development and application in your application.

|

The tools and drivers related to System_Disk that install on WP-8x21-CE7.

Update

1

The installation packages related to WP-8x21-CE7.
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2. Getting Started

This chapter provides a guided tour of the WP-8000-CE7 installation and configuration that
describes the steps needed to download, install, configure, and run the basic procedures for user
working with the WP-8000-CE7 for the first time.

Before starting any task, please check the package contents. If any of the following package

contents are missing or damaged, contact your dealer, distributor.

WP-8121-CE7/WP-8421-CE7/WP-8821-CE7 A microSD card and a micro SD/SD adapter

Quick Start Guide Software Utility CD Screw Driver (1C016) 2.4 mm
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2.1. Mounting the WP-8000-CE7

The WP-8000-CE7 can be mounted either directly to a wall/panel, or onto a standard 35mm DIN
rail.

Wall/Panel mounting

Step 1: Install the four mounting
screws into the 4 keyhole
mounting holes

Step 2: Fasten the screws securely

Tips & Warnings

A There must be a minimum clearance of 50mm between the WP-8000-CE7
and the top and bottom side of the enclosure panel.
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DIN Rail mounting

Step 1: Hook upper tab over upper flange of DIN rail

Step 2: Tilt the module toward DIN rail until it snaps securely to DIN rail

Step 3: Push up retaining clips

O O O O o G

Gently push up retaining clips
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Tips & Warnings

A good common ground reference (earth ground) is essential for proper

A operation of the WP-8000-CE7. One side of all control circuits, power
circuits and the ground lead must be properly connected to earth ground by
either installing a ground rod in close proximity to the enclosure or by
connecting to the incoming power system ground. There must be a
single-point ground (i.e. copper bus bar) for all devices in the enclosure that
require an earth ground.

Connect the ground lead to the ground screw
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2.2. Deploying a Basic WP-8000-CE7 System

The WP-8000-CE7 provides a variety of communication interface to suit a range of application.

Here is a simple application for using the WP-8000-CE7.

Step 1: Connect the positive terminal (+) of the power supply to the terminal PWR1/2
and the negative terminal (-) of the power supply to the P.GND

Tips & Warnings

2 1. The input range of power supply is +10 to +30 Vpc.

2. The WP-8000-CE7 have two power inputs that can be connected
simultaneously to the two independent power sources. If one power
source fails, the other source takes over automatically. Redundant power
inputs help assure non-stop operation of the WP-8000-CE7.

Power Supply 1
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Step 2: Connect the USB mouse or the USB keyboard to the USB port
Step 3: Connect the monitor to the VGA port

Step 4: Connect to PC or the laptop to the LAN port via an Ethernet switch

Monitor

PWlez I D—I :
G ]
£.GNE UsB Port

USB Mouse or Keyboard

Ethernet
+24 Voc Power Supply Switch
(+10 to +30 Vo)
PC or Laptop
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2.3. Installing the I/0 Modules

WP-8000-CE7 has 1/4/8 1/0O expansion slots and only supports I-8K and I-87K series /O modules.

Before choosing the right I/0O modules, you first need to know the I/O expansion capacities in
order to choose the best expansion module for achieving maximal efficiency. For more information
about the I/0O expansion modules that are compatible with the WP-8000-CE7, please refer to:
http://www.icpdas.com/en/product/guide+Remote | O  Module and _Unit+Software Supp
ort +I-8K |-87K Software Support

Step 1: Align circuit card with slot and press firmly to
seat module into connector

Tips & Warnings

It is recommended that the power to the WP-8000-CE7 is switched off when
wring the 1/0 module which are plugging in the WP-8000-CE7 slots.
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http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support
http://www.icpdas.com/en/product/guide+Remote__I_O__Module__and__Unit+Software__Support__+I-8K_I-87K__Software__Support

Step 2: Pull top and bottom locking tabs toward module face. Click indicates lock is
engaged

]

Step 3: Attach field wiring using the terminal block, and then insert the terminal block

All I/O Web Page include the 1/0 module specifications, pin assignments and wiring
connections.

For example, Pin Assignments and Wiring connections for the 1-87054W module are
as follows:

http://www.icpdas.com/en/product/I-87054-G

nTa i TaTatitutaTs’
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2.4. Configuring the Boot Mode

The WP-8000-CE7 has several operating modes, which can be selected by a rotary switch.

The table below lists the operation modes available with the WP-8000-CE7.

Position Operating Mode

0 Normal mode (Default)

Safe mode

Debug mode

OS update mode by Ethernet

Reserve

OS update mode by microSD

o (L |k W N

Reserve (OS Development Mode)

7~9 User Mode

The following is a brief introduction of these modes.

Normal Mode (Default mode)

Normal mode is the default mode of operation and the one you will use most of the
time. Use this mode for more tasks and configurations. Programs also are executed in
this mode.
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Safe Mode

Safe mode is a troubleshooting mode. The mode loads the minimum required device
drivers and system services to boot the WP-8000-CE7.

If you have malicious software or a program caused the WP-8000-CE7 cannot be boot
or run the normal mode, you can boot in safe mode to solve the problem.

Debug Mode

Debug mode is a special environment in which program debug functions can be used
in addition to normal system functions.

Debug mode is unsupported.

OS Update Mode

OS update mode is a way used to update OS. For more information on updating the
WP-8000-CE7 OS image, please refer to section 7.1. OS updates

Reserve — OS Development Mode

The positions 4, 6, of rotary switch are reserved for OS development.

User Mode

The positions 7, 8, 9 of rotary switch are reserved for user’s applications.

When WP-8000-CE7 is boot with one of these positions, it is boot at normal mode.

User’s application can check the position of the rotary switch position to run at
different mode.
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2.5. Changing the User Interface Language

The Regional and Language Settings is a Windows CE functionality that allows users to change the

WP-8000-CE7 user interface with your native language.

Step 1: Click Start menu, point to Settings, click Control Panel, and then click Regional
Settings

@ Prograrns ’
'{? Faviorites r
D Documents
B Settings

B Contral Panel
(}, Metwork and Dial-up Connections
E Taskbar and Start Men...

Settings

Regional and Language Settings

Regional Settings Lser Intetface Language I Input Language |

-Your locale

The locale option affects how some programs format numbers, currency,
time and dates,

Customize...
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Step 2: Click User Interface Language tab, choose to your local language, and then click
OK button

Regional and Language Settings m

| Regional Settings | User Interface Language | Input Language |
-User Interface Language

The option will determine the language used for the menus, dialogs
and alerts,

English (United States El

French (France)

German (Germnarny)

Ttalian (Ttaly)

Portuguese (Brazil

Spanish (Spain - International Sort)

Step 3: Double-click the PAC Utility on the desktop, and then reboot the WP-8000-CE7
for changes to take effect

Double-click

the PAC Utility J PAC Utility [1.2.1.4]

iiE Help .
Save ﬁ
Save and Reboot e | ERAES 7

Reboot

'

i

o
Restare Utility Default Settings A
Exit {
PAC UtP

a3
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2.6. Using PAC Utility to Manage the WP-8000-CE7

The PAC Utility is a collection of the WP-8000-CE7 system tool that allows users to manage and
configure the WP-8000-CE7 quickly and easily.

For more detailed information on PAC Utility applications, please refer to “3.1. PAC Utility”

Step 1: Double-click the PAC Utility on the desktop

Step 2: Configure IP address (DHCP), FTP Server, Auto Execution files..., etc.

N ||
% / ‘E_ile Help
- General | General2 ID\sp\ay IIP Config | Network |Dewce Infarmation I AUtn Execution IRntary E}{d l I >

ACcess Login

Double-click
the PAC Ut'"ty FTP @ Enable () Disable

Allow Anonymous @ Enable (O Disable

Set FTP default download directory to:

[ Lo | ot |
Iy Device

- Network
Set HTTP dof - Systemn_disk
windowstw] --Recycled Apply

- Application Data

i+ My Recent Documents
i+ My Documents

I——————————————o ProgramFiles |
e Windowes
Cancel | Ok
Step 3: Reboot the WP-8000-CE7 for changes to take effect
PAC Utility [1.2.1.4]

iﬁﬁ Help 7

Save ﬁ’

Save and Reboot prifig | Network 3

Reboot {'I
— L
s

Restore Litility Default Settings £

Exit {

AC Uty

™

WP-8000-CE7 Series User Manual, version 1.0.2 Page: 32

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com



2.7. Using DCON Utility Pro Configure I/0 Modules

DCON Utility Pro allows users to configure and manage the I/0O modules via Ethernet or serial ports
(RS-232/RS-485).

Step 1: Double-click the DCON_Utility_Pro on the desktop

Double-click the
DCON_Utility_Pro
.

Step 2: Click the button

il

DCON Utility Pro CE ¥ 2.0.0.5

|

SIDEY &R

St Address [0 | End Address

D IAddr... |Baud Rate IChecka... |Format|5ta1u5 |Descriptiom

1] | [#
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Step 3: Configure the communication settings

COM Port Option

COM Port Timeout
COMO[Backplane] =] 300 ms
ol ecksum | Format
COM2 |
COomM3
oM B2 [JEB1 [Joa1
QK Cancel
Tips & Warnings

A The COM port settings for expansion I/O modules are listed below.

COMO [Backplane] <&

\ 4
comi/2/3/a

For more information on these COM port selections, please refer to the

specification of the pin assignments in section 1.3. Overview
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Step 4: Click the E button to scan the I/O module

Step 5: Click the module name to configure the I/0 module

DCON Utilit. Bro CE ¥ 2.0.0.5

HOna=
Start Address El End Address
Addr...J Baud Rate |Check5... IFormatI Stahus IDescription
97015 R 5200 Disable ML,E, 1 [DCONIB*AT (Universal RTO
97015 Yirmware[B200]
Configuration |.£\I |Abc.ut|
ProfocolNIT*)  [ooon =l
Address 0 E [00H]
Baud Rate(NIT*)  |115200 =
Parity (INIT*) {1,2, 1-Mone Parity 5]
Checksum(INIT*)  |Diszble =
1] Analog Format Ohms [~
[ 60750 Hz E =]
COM:O[N,8,1] |f Save Configurations to the File
Write Confi L1 to 1/0 Modul
Response Delay Emg ‘ riee Lonrnguraaons to _.-“ odue
Exit |

WP-8000-CE7 Series User Manual, version 1.0.2

Page: 35

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. DX E-mail: service@icpdas.com




3. Tools and Tasks

This chapter provides a brief introduction of the WP-8000-CE7 service tools and its benefits.

There are several tools and utilities built-in and designed for use with WP-8000-CE7. Some of these
are pre-installed on WP-8000-CE7 and can work directly on WP-8000-CE7, and some of these are
supporting tools and can help you to manage the WP-8000-CE7 remotely on a PC.

The following tools are pre-installed on WP-8000-CE7 and can work directly on WP-8000-CE7 that
can be found on the CD that was provided with the package or by downloading the latest version
from ICP DAS web site.

CD:\WinPAC_AM335x\wp-8x2x\System_Disk\Tools\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/system_disk/tools/

B ocon vy rro
N o mstr ool
T
T
T
B cemoic oipi
N senimocon
T
e
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3.1. PAC Utility

PAC Utility is a collection of software applications that enable management and configuration of
WP-8000-CE7 system and features.

PAC Utility [1.2.1.4] ! E

- General | Generalz I Dizplay IIF' Canfig INetwcurk IDevice Infor matian Ihub:u Execution IRDtary Exg 1] ¥

Welcorme to use PAC Uitility
This tool will help you easy o
Lse PAC CE series.

PAC Utility

Task Bar setting:
[ &wuto Hide

[ alhways On Tap

HIVE Registry:
@ Auto Save Ta Flash (Default)

() Maunal Save To Flash

Backplane Battery [7] Enable &utorun in plugging LSE Disk
Batteryl : Ok Battery2 : Ok [[] Enable &utorun in plugging Micra S0

RTC Battery

Canfigure the synchronization with a time server | Configure | | Backlight Setting

The PAC Utility includes the following menu bars and property tabs.
All of these functions will be explained later.

File General

Help General2
Display
IP Config
Network

Device Information

Auto Execution

Rotary Execution
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3.1.1. Menu Bar -File

iﬁﬁ Help

Save
Save and Reboot
Reboot

Restare Utility Default Settings
Exit

The menus use to How to use

Reboot Restarts the WP-8000-CE7

Restore Utility Default Settings Restore the WP-8000-CE7 to default settings.

Exit Exits the PAC Utility.
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3.1.2. Menu Bar — Help

Ahout PAC Utility

PAC Utility
Yersion: 1.2.0.5

Copy Right () 2005, ICPDAS Co., LTD.
All Rights Reserved, PAC Utility and the
PAC Utility logos are rademarks of
ICPDAS,

P&C Windows CE; en-US)

The menus use to How to use

About Displays a dialog box with information about PAC Utility,
including the current version and copyright information.
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3.1.3. Property Tab - General

The General tab provides functions to configure the task bar, check the status of the battery..., etc.

PAC Utility [1.2.1.4]

File Help

Welcome o use PAC Utility
This 1oal will help you easy to
Lse PAC CE series,

Taszk Bar setting:
[ suto Hide
[ sbways On Top
HIYE Reqgistry:
® suto Save To Flash (Defaulty
{3 Maunal Save Ta Flash

Backplane Battery [7] Enable sutarun in plugging USE Disk
Batteryl : Ok Batteryz @ Ok [] Enable sutarun in plugging Micro SO

RTC Battery

Canfigure the synchronization with a time server | Configure | | Backlight Setting

Lock or Auto-Hide | Auto-Hide the taskbar:
the taskbar Select the Auto Hide check box.
Lock the taskbar:

Select the Always On Top check box.

Auto save or Auto save to flash:

manual save to Select the Auto Save To Flash (Default) check box.

flash Any changes made to the WP-8000-CE7 will be saved and only take
effect after the WP-8000-CE7 reboots.

Manual save to flash: PAC Utility [1.2.1.4]
Select the Manual Save to Flash JI=Y Help

check box. Save and Reboot

Any changes made to the Reboat

WP-8000-CE7 will be saved by >
Restore Utility Default Setti
clicking the Save and Reboot from E;i o IR HEtEU Setioe
File menu. W
WP-8000-CE7 Series User Manual, version 1.0.2 Page: 40

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. DX E-mail: service@icpdas.com



The tab use to How to use

Enable USB autorun Select the Enable Autorun in plugging USB Disk check box.

Enable microSD auotrun This item is temporarily unavailable.

Automatic synchronization | Refer to the Appendix A.2. How to configure the service for
of system time automatically synchronizing with the internet time server.
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3.1.4. Property Tab — General2

The General2 tab provides functions to specify the name of the USB disk.

PAC Utility [1.2.1.4] ! E m
| Fie_telo |

General | General2 | Display I IF Config I Network I Device Information l Auto Execution l Rotary Exe 4| »

Naming the CF Card and USB Hard Disk

Set

USE Hard Disk: |USB_Disk |

Specify the name of the USB disk ‘ Enter a name in the USB Hard Disk: field
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3.1.5. Property Tab — Display

The Display tab provides functions to configure the monitor settings.

File Help

I General I General? |

Screen resolution: Screen refresh rate:

Less I M+lare: EI

640 by 480 pixels

The tab use to How to use

) Move the slider to the left to decrease the resolution or move the
Adjust the screen ] ) ) ) ]
) slider to the right to increase the resolution, and then click the Apply
resolution
button.

Change the screen Select the desired refresh rate from the Screen refresh rate
refresh rate drop-down list, and then click the Apply button.
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3.1.6. Property Tab - IP Config

The IP Config tab provides functions to configure either DHCP (Roaming) or manually configured
(Static) network settings and to monitor the MAC address. Generally, DHCP is the default settings,
but if you don’t have a DHCP server, you must configure the network settings by using manual
configuration.

PAC Utility [1.2.1.4] ! E

LAM 1: LAN 2:

MaC Address: 00-00-E0-55-66-01 MaC Address: 00-0D-E0-55-66-D2

{3 Use DHCP to get IP address {) Use DHCP to get IP address

) 2ssign IP address @ tssign IP address

IP Address: ‘ | IP Address: | |

Mask: ‘ | Mlask: | |

Gateway ‘ | Gateway | |

OMS Server: ‘ | DMNS Server: | |
[T] Reboot for changes to take effective [T] Reboot for changes to take effective

Use DHCP to get IP address:
Select the Use DHCP to get IP address option, and then click the Apply
button.

Set the network

settings .
Assign an IP address:
Select the Assign IP address option, and then click the Apply button.
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3.1.7. Property Tab — Network

The Network tab comprises three tabs — Access, Login and File Server Settings.

Access

The Access tab provides functions to enable/disable the FTP access, enable/disable anonymous
FTP access, and configure the FTP and HTTP directory path.

PAC Utility [1.2.1.4] ! E

[General General2 IDispIay IIF' Config | Metwark | Device Information I ALt Execution I Rotary Exe 4| 0

Access | Login | File Server Settings |

FTF (@ Enablz () Disable

Allow Anonymous (@ Enable () Disable

Set FTP default download directory to:

' [

Set HTTF docurment root directory to:

W IS i e LI, H || Apply

reuowso —ovome

Enable the FTP access:

Select the Enable check box in the FTP field, and then click the
Enable or disable the Apply button.

FTP access Disable the FTP access:

Select the Disable check box in the FTP field, and then click the
Apply button.
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The tab use to How to use

Enable anonymous FTP access:
) Select the Enable check box in the Allow Anonymous field, and then
Enable or disable )
click the Apply button.
anonymous FTP .
Disable anonymous FTP access:
access
Select the Disable check box in the Allow Anonymous field, and then
click the Apply button.
Set the FTP Enter a new path in the Set FTP default download directory to: field,
directory path and then click the Apply button.
Set the HTTP Enter a new path in the Set HTTP document root directory to: field,
directory path and then click the Apply button.
Login

The Login tab provides functions to maintain the FTP accounts.

PAC Utility [1.2.1.4] ! E

[General I General2 IDispIay IIF' Config | Metwork | Device Information Iﬁuh:u Execution IRDtary E}{EI 1 I 4

[Access | Login | File Server Settings |

User Natme Password

Jdmin | [+ || add || Deete

Lser name Passwiord

The tab use to

Maintain the FTP Refer to the Appendix C.1 How to add a user account to remote
accounts login the WP-8000-CE7 from PC.
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File Server Settings

The File Server Settings tab provides functions to set the SMB server.

PAC Utility [1.2.0.6] M [=]

IGeneraI I Digplary IIF' Config ‘ Metwork | Device Information Iﬂub:l Execution IRDtarﬁ,r Execution |

ACCEess I Login | File Server Settings |

fou can create a networked file server and enables clients to store and
retrieve files, and makes use of the Internet for communication between
client devices and other shared equipment,

_ J|| Settings Share Files System Settings !

Device Mame (Each device need setting
a different device name)

Compact

The path 1o the folder to be shared

Configure the file server to use LANY as
the network adapter

|PCrFETCESRZ Bd

Enzble all authentication on the file

server, The file server will not be
accessible o all users on the

[ retwork and the "admin" as the

Lser to be allowed access o the

file server

Set

Help

‘ Set the SMB server ‘ Click the Settings button to set the SMB server path. ’
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3.1.8. Property Tab — Device Information

The Device Information tab provides functions to monitor necessary system information of the
WP-8000-CE7. The information is the most important note of version control for upgrading system.

PAC Utility [1.2.1.4] ! E
File Help
[General IGeneraIE IDispIay IIF' Config I Metwork | Device Information | Auto Execution IRDtar':.-' Exg 1] ¥
Slot 1: I:I Module{CPL) Type: | |
Slat 2: I:I Serial Mumber |E|1—82—4D—DE.—18—DD—DD—DA |
Slot 3: I:I Backplane Yersion: | |
Slot 4; |:| CPU Wersion: lLo.00 |
Sots: [ ] 0Swversion: [1.0.1.1, 2015/10/30 09:36:5 |
Slot 6: |:| Eboot Version: [1.2.1.0, 2015/10/22 16:26:0 |
sot7: [ |  METCFversin:  [3.57338.00 |
SQL CE Version: 581540 |
PACSDK Yersion: 4334 |
CPU Temperature: | |
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3.1.9. Property Tab — Auto Execution

The Auto Execution tab provides functions to configure programs running at WP-8000-CE7 startup,

it allows users to configure ten execute files at most.

Tips & Warnings

Q The specific extensions are .exe and .bat, and they are executed in order of
program 1, program 2, etc.

PAC Utility [1.2.1.4] ! E

[ General I General2 I Display I IF Config I Metwork IDeuice Information | Auto Execution | Rotary Exg 1| ¥

Program 1: |"-.-"_REMDTE.E}{E | Browse |

Prograrm 2 | | | Browse I
Prograrm 3: | | | Browse I
Prograrm 4: | | | Browse I
At most 10 programs  Fregram S: | | | Brawse |
can be specified to .
ExeCUtE autormatically Frogram &: | | | Browse |
at system startup. Program 7: | | " Browse |
Program 2: | | | Browse |
Prograrm 9: | | | Browse |
Programl0; | | | Browse I

The tab use to
Configure programs Click the Browse button to select the execute file which you want,
running at startup and then click the Apply button.
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3.1.10. Property Tab — Rotary Execution

The Rotary Execution tab provides functions to configure programs running at WP-8000-CE7
startup in one of the user defined mode, it allows users to configure ten execute files at most.

PAC Utility [1.2.1.4] ! E

[GeneraIE IDispIay IIF' Config INetwurk IDevice Informatian Iﬂu’o:u Execution | Raotary Execufion I_I\I L

Rotary Switch 0 |Nurmal Mode | | Browse |
Rotary Switch 1: [Safe Mode | _Browse |
Rotary Switch 2. | | . Browse |
Rotary Switch 3: | | _erowse |
Rotary Switch 4. | | | Browse |
Rotary Switch 5: | | _Browse |
Rotary Switch 6. | | . Browse |
Rotary Switch 7: | | _Browse |
Rotary Switch 2: | | . Browse |
Rotary Switch 9: | | _Browse_|

Configure programs running at startup | Click the Browse button to select the execute file

in one of the user defined mode which you want, and then click the Apply button.
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3.2. DCON Utility Pro

DCON Utility Pro enables users easily to configure and manage the I/O modules via Ethernet or
serial ports (RS-232/RS-485).

For more information on how to use DCON Utility Pro to configure I/0O modules, please refer to 2.7.
Using DCON Utility Pro to Configure I/O Modules

For more detailed information on DCON Utility application, please refer to:
http://www.icpdas.com/en/product/guide+Software+Utility Driver+DCON _ Utility Pro

DCON Utility Pro CE V 2.0.0.4

Start Address 0 End Address |4
o Addr... | Baud Rate | Checks... |Format| Status | Description

Terminal Command Line Tool
COMPort  |COMO[Backplane x| Protocol — [oon =
BaudRate  [115200 iFormat  |i,3,1-None Parity [ Send
Checksum  [Disable T gt [sltol=] | =]
Timeout 100 ms SelectlD | 4
Command 400M
Resporse
|
4 I E ata Logger I Aboutl
| ZonM Port Com Port ICOMD E LEEE)
ICOMD E Protocal IDCON :I
Baud Rate [115200 ~] Remove
Data Format |N,8J1 El Add ==
Checksurm IDisabIe :I
Slot | ~] Madify rty |
Timeout {ms) Iggg(ms) E' Cave
Delay for Mext (ms) |2E|E|(ms) :I
Command Reference | E'
Send Command |$DlM |
Compared Response |Input Compared Data |
Compare Made |Fu|| Match El
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3.3. TaskMgr

The TaskMgr is a Windows CE application, which provides real time info on all processes and

threads including System threads, similar in appearance to the Windows Task Manager.

Windows CE Task Manager

Performance IPmcesses Iﬁpp]j;:aticu 1 n
100

Windows CE Task Manager

TaskIvlanager e
w_remote exe
servicesd exe
explorer.exe |
Usage 8% CGurellzer exe Task
udevice exe
| udevicerne V. Virtual CE
W EYE
1
|
4I | N
Close Switch
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3.4. VCEP

ICP DAS VCEP is designed for managing your WP-8000-CE7 anywhere. No matter where you are,
ICP DAS VCEP provides a convenient environment on the Desktop PC and lets you control your
WP-8000-CE7 remotely.

=
VirTual CE 5
Connected
Ready

Primary IF = 10.1.0.95
License Free Version

Wideo=G01

Wiy iCpdas, com

ICP DAS VCEP is composed of two main components: The Server which runs on WP-8000-CE7 and
the Client which runs on a Desktop PC.

Once a connection is established between the client and server (initiated by the client), the client
will periodically send requests for screen updates and send mouse/key click information to the
server to simulate.

Each video frame is inter-compressed against the previous frame and then intra-compressed with a
modified LZW scheme to minimize the amount of data transmitted from server to client.

For more detailed information on VCEP application, please refer to

http://www.icpdas.com/en/product/guide+Software+Applications+VCEP  (Virtual CE Pro)
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3.5. Remote_Display

The Remote Display allows WP-8000-CE7 to be controlled and monitored from a remote location.

This tool is composed of two parts, a client and a server. The server is a program named
cerdisp.exe running on WP-8000-CE7. The client is a PC-based program named cerhost.exe running
on the PC.

cerdisp cerhost

Once a connection is established between the client and server (initiated by the client), the client
will periodically send requests for screen updates and send mouse/key click information to the

server to simulate.
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3.6. SendToCOM

The SendToCOM uses the serial port to communicate with expansion module. To use the
SendToCOM, you can send data to expansion module through the serial port, and receive data

from other device through the serial port.

For more information about these commands for communicating with expansion module, please
refer to:
CD:\WinPAC\napdos\io_module\87k_high_profile_modules.htm

ICPDAS Send to COM V1.0.4 2011f2/23
Connection Status
COM Part Baudrate [rata Bit Parity: Stop Bit Slak
|COM2 ~] |1152|:n:| ~] |8 :I IIZI—Nu:une Parity | w| |1 =] | E2
Endstring with @ mone (YLFcR (YR (O criF OWF [string | 4 +cre
Binar Skrin m Polling
Carmmands Responses O ! @ d - -
Current Packet Size (bytes) g Current Packet Size (bybes) g fuka send Inkernal (ms)  |sop
Total Packet Bytes il Tokal Packet Bykes il | Skark | | Stop | Sek
Packet Quantity send ] Packet Quantity received |0 ckart Time |Start Time
ﬂl Stop Time  |5top Time
FS FS
w w
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3.7. RegEdit

The RegEdit provides a hierarchical representation of the registry on a target computer, similar in
appearance to the Windows Registry Editor. The standard registry roots are represented; you can
add keys beneath a root to point to existing registry keys, or you can add your own keys. Values can
be changed for existing keys, or added for new keys, and default keys can be specified. For more

information, see Registry Settings Management in Deployment.

Registry Editor Version 1.2.2 ! ﬁ

File Help

HKEY_C i

& HKEY_CURREMT _LUSER

B HREY_LOCAL_MACHINE
L HKEY_USERS

Marme I Type I Data I
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3.8. 1SQLW35

The ISQLW35 is a Windows Embedded Compact 7 functionality that implements SQL Server
Compact 3.5 Query.

soL | [ arid Mates

----- {a T atabases

Tools 501 | f A U X
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3.9. INotepad

The INotepad is a common text-only editor. The resulting files have no format tags or styles.

INotepad !
File Edit Format Help

Esc|1|2|3|4]|5]|6(7 9(0[- (=]
Tablawle]r[t]y[ulifo]p|r]]
CAP|a|s |d|[f[g|h|]]k]|I]/
Shift| z [x[c|v[b[n[m]|.]. ]/
A ctifaii~ T4 ] Lt]e]>
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4. Your First WP-8000-CE7 Program

This chapter provides a guided tour that describes the steps needed to set-up a development

environment, download, install, configure for user programming with WP-8000-CE7 modules.

4.1. Setting up the Development Environment

Before writing your first program, ensure that you have the necessary development tool and the
corresponding SDKs are installed on your system.
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4.1.1. Preparing the Development Tools and Programming Languages

WP-8000-CE7 is a Windows CE-based device that supports three programming languages for
developing Windows CE applications.

e Visual Basic.NET
e Visual CH

e Visual C++

Development Tools

WP-8000-CE7 supports the application development with the Professional Edition application of
Visual Studio 2008.

\ Micrpsoft' .
P Visual Studio 2008

Professional Edition

Tips & Warnings

A There are some updates for Visual Studio 2008 to provide support for
Windows Embedded Compact 7.

If you have Professional Edition of Visual Studio 2008 are installed, make

sure all of the following package are installed

1. Visual Studio 2008 Service Pack 1

http://www.microsoft.com/en-us/download/details.aspx?id=10986

2. Visual Studio 2008 update for Windows Embedded Compact 7

http://www.microsoft.com/en-us/download/confirmation.aspx?id=11935

3. Windows Embedded Compact 7 ATL Update for Visual Studio 2008 SP1

http://support.microsoft.com/kb/2468183/en-us
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4.1.2. Installing the WP-8000-CE7 SDK

The WP-8000-CE7 SDK offers several APIs for customizing the standard features and integrating
with other applications, devices and services.

Step 1: Get the latest version of the WP-8000-CE7 SDK, AM335x_WINCE7_SDKV100B03

The WP-8000-CE7 SDK can be found from the CD that was provided with the package

or by downloading the latest version from ICP DAS web site.

CD:\WinPAC_AM335x\WP-8x2x\SDK\PlatformSDK\
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-8x2x/sdk/platformsdk/

Step 2: Execute the AM335x_WINCE7_SDK_YYYYMMDD.msi

Follow the prompts until the installation process is complete.

Step 3: Execute the VisualStudioDeviceWindowsEmbeddedCompact?7

Follow the prompts until the installation process is complete.

WP-8000-CE7 Series User Manual, version 1.0.2 Page: 61

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com



http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/sdk/platformsdk/

4.1.3. Setting up the Global Compiler Settings (for Visual C++)

The directories can be specified where the compiler will search for include files and libraries.

Step 1: Start Visual Studio 2008

"2

Step 2: On the Tools menu, click Options...

File Edit View |Tools | Test Window Help
Attach to Process... Ctrl+Alt+P

Device Security Manager...

s

Connect to Device...

M’:Wlatnr Mragg_r' - "r -

L 4

Visual Stuu.. 004 Command Prompt
8 | WCF Service Configuration Editor

External Tools...

Import and Export Settings...

Customize...

Options...
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Step 3: In the Options dialog box, expand the Projects folder, and then click the VC++
Directories

Step 4: In the Show directories for: drop-down list, select Include files

Step 5: Use the buttons in the Options dialog box to add additional include paths

The path of “S(VClInstallDir)ce7\include” and “S(VClinstallDir)ce7\atimfc\include”
must be moved to the top of the list.

Options - M

Environment Platform: Show directories for:
Projects and Solutions |AM335x_WINCE7_SDK (ARMv4)  ~| [Include files ~|
General
Build and Run
VB DEfa':'Its : $(/CInstallDir)ce\include -
| VC++ Directories $(VCInstallDir)ce7\include
| WC++ Project Settings CA\Program Files (x86)\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\include
Source Control C\Program Files (x86)\Windows CE Tools\SDKs\AM335x_WINCE7_SDKiincludel,
| Text Editor $(VCInstallDir)ceMatimfc\include

| $(VClInstallDirjce\atimfc\include

Database Tools $(VSInstallDir)SmartDevices\SDK\SQL Server\Mobile\v3.0
Debugging

Device Tools

HTML Designer

Office Tools

Test Tools

I Text Templating

[ Windows Forms Designer
Workflow Designer

< | I | >

Include Directories
Path to use when searching for include files while building a VC++ project. -
Corresponds to environment variable INCLUDE.

OK ] l Cancel
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4.2. First WP-8000-CE7 Program in VB.NET

The best way to learn programming with WP-8000-CE7 is to actually create a WP-8000-CE7
program.

The example below demonstrates how to create a demo program running on WP-8000-CE7 with
VB.NET.

To create a demo program with VB.NET that includes the following main steps:

1. Create a new project

2. Specify the path of the PAC reference

3. Add the control to the form

4. Add the event handling for the control

5. Upload the application to WP-8000-CE7
6. Execute the application on WP-8000-CE7

All main steps will be described in the following subsection.

In this tutorial, we will assume that you have installed WP-8000-CE7 SDK on PC and used the Visual
Studio 2008 for application development.
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4.2.1. Create a new project

The Visual VB.net project template is a composite control that you use in this example creates a
new project with this user control.

Step 1: Start Visual Studio 2008

"2

Step 2: On the File menu, point to New, and then click Project

File | Edit View Tools Test Window Help

New » o] Project. Ctrl+Shift+N
| Open » | @  WebSite.. Shift+Alt+N
Close ' | File.. Ctrl+N

7] | Close Solution Project From Existing Code...

7 | Save Selected Items  Ctrl+5S
Save Selected Items As...

@ SaveAll Ctrl+Shift+S
Export Template..

Lt | Page Setup...

4 | Print... Ctrl+P
Recent Files 2
Recent Projects »
Exit
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Step 3: In the Project types pane, expand Visual Basic node and select Smart Device

Step 4: In the list of Templates, select Smart Device Project

Step 5: Specify a name and a location for the application and then click OK

Project types: Templates: I-NET Framework 3.5 ~ ]

General + || Visual Studio installed templates

MFC | yElSmart Device Project|

Smart Device

Test

Win32

Other Languages

Visual Basic
Windows
Web
Smart Device
Office
Database
Reporting
Test L
WCF
Workflow

Visual C#

A project for Smart Device applications. Choose target platform, Framework version, and template in the next dialog box.

—[| My Templates

.}dSearch Online Templates...

11

-

Name: SDK Info
Location: C\Users\Administrator\Documents\Visual Studio 2008\Projects - Browse...
Solution Name: SDK_Info Create directory for solution
OK I l Cancel l
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Step 6: In the Target platform, select Windows CE

Step 7: In the .NET Compact Framework version, select .NET Compact Framework

Version 3.5.

Tips & Warnings

Windows CE7 only supports .NET Compact Framework Version 3.5, if your

application uses .NET Compact Framework Version 2.0 there is no guarantee

that the program will function correctly.

Step 8: In the list of templates, select Device Application. Click OK

Add New Smart Device Project - SDK Info ‘
—

Target platform: ’Windc:-ws CE

NET Compact Framework version: ’.NET Compact Framewaork Version 2.5

Templates:
Device Class Console Control Empty

Application  Library  Application  Library Project

Download additonal emulator images and smart device SDKs...

E=

Description:

A project for creating a .NET
Compact Framework 3.5 forms
application for Windows CE
Platform

ok || cancel |
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4.2.2. Specify the path of the PAC reference

The PAC SDK provides a complete solution to integrate with WP-8000-CE7 and it’s compatible with
Visual C#, Visual Basic.NET and C++. In order to use a component in your application, you must first
add a reference to it.

Stepl: Get the PACNET.dII

e

ﬁﬂé

PACNET.II

The PACNET.dIl can be found from the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.

CD:\WinPAC_AM335x\WP-8x2x\SDK\PACNET\
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-8x2x/sdk/pacnet/

Step 2: On the Project menu, and then click Add Reference...

ﬁg SDEK Info - MicrosofTVisuaEtudio (Administrator)_;—;: . #
File Edit View W' Build Debug Data Format Tools Test Window Help

5] | Add Windows Form...

4 Add User Control...

]| Add Component..

2] Add Module..

vi¢ | Add Class..

|24 | Add New Item... Ctrl+Shift+4

Add Existing Item...  Shift+Alt+A

Exclude From Project
3 | Show All Files

Add Reference...

Add Web Reference...
Set as StartUp Project

+4 | Refresh Project Toolbox Items

Change Target Platform...
SDK_Info Properties... Alt+F7
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Step 3: On the Browse tab and browse to where the PACNET.dIl are installed, and then
click OK

| .NET | Projects| Browse | Recent
Lookin: | PACNET v @ T @
Mame N Date modified
| @) PACNET.AII 2014/5/30
< | 1T b
Filename: : PpPACNET -
Files of type: : [Component Files (¥.dl1;* tlb;* olbs* ocxs® exa) v]
OK ‘ ‘ Cancel
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4.2.3. Add the control to the form

You can drag various controls from the Toolbox onto the form. These controls are not really "live";
they are just images that are convenient to move around on the form into a precise location.

After you add a control to your form, you can use the Properties window to set its properties, such
as background color and default text. The values that you specify in the Properties window are the
initial values that will be assigned to that property when the control is created at run time.

Step 1: On the Toolbox panel, drag a Button control onto the form

‘

Toolbox + 11 X
All Device Controls &)
B Common Device Contr...

k Pointer
| Button

CheckBox
ComboBox

T DateTimePicker
A Label

A LinkLabel
ListBox

:: ListView

F] MonthCalendar
NumericUpDown
[ PictureBox

@ ProgressBar

® RadioButton

+|+ Splitter

TextBox

% TrackBar

i TreeView

= WebBrowser
Device Containers o
Device Menus & Toolb...
Device Data

Device Components
Device Dialogs

B General -

a5 | T. B AR]

m
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Step 2: On the Properties panel, type Check the SDK version in the Text field

Properties E
Buttonl System.Windows.Forms.Button -
o=]4) [B]# |E
=B Appearance il
BackColor |:| Control
Font Tahoma, 10pt |=
ForeColor . ControlText 4 ‘
Check the SDK Version| M\’_‘lﬁ___
= Behavior
ContextMenu (none)
DialogResult None . .
Enabled True % Check the SDK Version J
TabIndex 0
TabStop True -~
Text
The text contained in the control.
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4.2.4. Add the event handling for the control

You have finished the design stage of your application and are at the point when you can start

adding some code to provide the program's functionality.

Step 1: Double-click the button on the form

a Check the SDK Version
LF

Step 2: Inserting the following code

Dim data(30) As Byte
PACNET.Sys.GetSDKVersion(data)

MessageBox.Show(PACNET.MISC.WideString(data))

EPohlic Class Forml ;3
{

Private Sub Buttonl Click(BvVal sender As Svstem.0bject, ByVal e @EL
3

Din data(30) As Byte ~

PACHET .5vs.GetsDEVersionidata) {}

| MessageBox . Show(PACKET . MISC . WideString{data)) f}

End Suh
End Class E}

\/wmwwvmumw ""“v"‘"‘\f

Tips & Warnings

A The “PACNET” of “using PACNET” is case- sensitive.
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4.2.5. Upload the application to WP-8000-CE7

WP-8000-CE7 supports FTP server service. You can upload files to WP-8000-CE7 or download files
from a public FTP server.

Step 1: On the Build menu, and then click Build [Project Name]

File Edit View Project |Build | Debug Data Format Tools Test Window Help
Build Solution F7
Rebuild Solution  Ctrl+Alt+F7

Deploy Solution
Clean Solution
## Build SDK_Info
Rebuild SDK_Info
Deploy SDK_Info
Clean SDK_Info

Configuration Manager...
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Step 2: Open the browser and type the IP address of WP-8000-CE7

Step 3: Upload the application and the corresponding PACNET.dII files to WP-8000-CE7

Tips & Warnings

A For applications programming in C# and VB.net with .net compact
framework, when executing these application on WP-8000-CE7, the

corresponding PACNET.dIl must be in the same directory as the .exe file.

| File Edit View Go Favorites ||”J|£
”]Agldress | YTemp

= O

PACMET SDK_Info

R/\U/v‘“"\

N N YA
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4.2.6. Execute the application on WP-8000-CE7

After uploading the application to WP-8000-CE7, you can just double-click it on WP-8000-CE7 to

execute it.

SDK_Info | Check the SOK Yersion | W
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4.3. First WP-8000-CE7 Program in Visual C#

The best way to learn programming with WP-8000-CE7 is to actually create a WP-8000-CE7
program.

The example below demonstrates how to create a demo program running on WP-8000-CE7 with
Visual C#.

To create a demo program with Visual C# that includes the following main steps:

1. Create a new project

2. Specify the path of the PAC reference

3. Add the control to the form

4. Add the event handling for the control

5. Upload the application to WP-8000-CE7
6. Execute the application on WP-8000-CE7

All main steps will be described in the following subsection.

In this tutorial, we will assume that you have installed WP-8000-CE7 SDK on PC and used the Visual
Studio 2008 for application development.
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4.3.1. Create a new project

The Visual C# project template is a composite control that you use in this example creates a new
project with this user control.

Step 1: Start Visual Studio 2008

"2

Step 2: On the File menu, point to New, and then click Project

File | Edit View Tools Test Window Help

New » o] Project. Ctrl+Shift+N
| Open » | @  WebSite.. Shift+Alt+N
Close ' | File.. Ctrl+N

7] | Close Solution Project From Existing Code...

7 | Save Selected Items  Ctrl+5S
Save Selected Items As...

@ SaveAll Ctrl+Shift+S
Export Template..

Lt | Page Setup...

4 | Print... Ctrl+P
Recent Files 2
Recent Projects »
Exit
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Step 3: In the Project types pane, expand Visual C# node and select Smart Device

Step 4: In the list of Templates, select Smart Device Project

Step 5: Specify a name and a location for the application and then click OK

Project types: Templates: I-NET Framework 3.5 ~ ]

Visual C++ Visual Studio installed templates
Other Languages ¥ Smart Device Project
Visual Basic
Visual C#
Windows
Web
Smart Device
MySQL
Office
Database
Reporting
Test
WCF
Workflow
Other Project Types
Test Projects

My Templates

2} Search Online Templates...

A project for Smart Device applications. Choose target platform, Framework version, and template in the next dialog box.

Name: SDK_Infq|
Location: CA\Users\Administrator\Documents\Visual Studio 2008\Projects - Browse...
|| Solution: [Create new Solution '] Create directory for solution
Solution Name: SDK_Info
OK I l Cancel
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Step 6: In the Target platform, select Windows CE

Step 7: In the .NET Compact Framework version, select .NET Compact Framework
Version 3.5.

Tips & Warnings

Windows CE7 only supports .NET Compact Framework Version 3.5, if your
application uses .NET Compact Framework Version 2.0 there is no guarantee
that the program will function correctly.

Step 8: In the list of templates, select Device Application. Click OK

Target platform: lWindows CE v]
NET Compact Framework version: I.NET Compact Framework Version 3.5 ']
Templates:
=

ol ﬂ%ﬁ] % E cﬁl 4

E a i @ m|c L

E il E Description:

Device Class Console Control Empty ] .

Application  Library  Application  Library Project A project for creating a .NET

Compact Framework 3.5 forms
application for Windows CE
Platform

|| Download additonal emulator images and smart device SDKs...

oK ] l Cancel
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4.3.2. Specify the path of the PAC reference

The PAC SDK provides a complete solution to integrate with WP-8000-CE7 and it’s compatible with
Visual C#, Visual Basic.NET and C++. In order to use a component in your application, you must first
add a reference to it.

Stepl: Get the PACNET.dII

e

ﬁﬂé

PACNET.II

The PACNET.dIl can be found from the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.

CD:\WinPAC_AM335x\WP-8x2x\SDK\PACNET\
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-8x2x/sdk/pacnet/

Step 2: On the Project menu, and then click Add Reference...

ﬁg SDEK Info - MicrosofTVisuaEtudio (Administrator)_;—;: . #
File Edit View W' Build Debug Data Format Tools Test Window Help

5] | Add Windows Form...

4 Add User Control...

]| Add Component..

2] Add Module..

vi¢ | Add Class..

|24 | Add New Item... Ctrl+Shift+4

Add Existing Item...  Shift+Alt+A

Exclude From Project
3 | Show All Files

Add Reference...

Add Web Reference...
Set as StartUp Project

+4 | Refresh Project Toolbox Items

Change Target Platform...
SDK_Info Properties... Alt+F7

WP-8000-CE7 Series User Manual, version 1.0.2 Page: 80

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com



http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/sdk/pacnet/

Step 3: On the Browse tab and browse to where the PACNET.dIl are installed, and then
click OK

| .NET | Projects| Browse | Recent
Lookin: | PACNET v @ T @
Mame N Date modified
| @) PACNET.AII 2014/5/30
< | 1T b
Filename: : PpPACNET -
Files of type: : [Component Files (¥.dl1;* tlb;* olbs* ocxs® exa) v]
OK ‘ ‘ Cancel
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4.3.3. Add the control to the form

You can drag various controls from the Toolbox onto the form. These controls are not really "live";
they are just images that are convenient to move around on the form into a precise location.

After you add a control to your form, you can use the Properties window to set its properties, such

as background color and default text. The values that you specify in the Properties window are the
initial values that will be assigned to that property when the control is created at run time.

Step 1: On the Toolbox panel, drag a Button control onto the form

Toolbox + 11 X
All Device Controls &)
B Common Device Contr...

k Pointer
| Button

CheckBox
ComboBox

T DateTimePicker
A Label

A LinkLabel
ListBox

:: ListView

F] MonthCalendar
NumericUpDown
[ PictureBox

@ ProgressBar

® RadioButton

+|+ Splitter

TextBox

% TrackBar

i TreeView

= WebBrowser
Device Containers o
Device Menus & Toolb...
Device Data

Device Components
Device Dialogs

B General -

a5 | T. B AR]

m
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Step 2: On the Properties panel, type Check the SDK version in the Text field

Properties E
Buttonl System.Windows.Forms.Button -
o=]4) [B]# |E
=B Appearance il
BackColor |:| Control
Font Tahoma, 10pt |=
ForeColor . ControlText 4 ‘
Check the SDK Version| M\’_‘lﬁ___
= Behavior
ContextMenu (none)
DialogResult None . .
Enabled True % Check the SDK Version J
TabIndex 0
TabStop True -~
Text
The text contained in the control.
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4.3.4. Add the event handling for the control

You have finished the design stage of your application and are at the point when you can start
adding some code to provide the program's functionality.

Step 1: Double-click the button on the form

% Check the SDK Version E

Step 2: Inserting the following code

byte[] data = new byte[30];
PACNET.Sys.GetSDKVersion(data);

MessageBox.Show(PACNET.MISC.WideString(data));

"“"’“_\m/l\-""";-'\fm\*ﬁ‘a\ N e e A VN A Sy

= private void buttonl Click{object sender, Eventhros el
{

bvte[] data = new hyvte[30];

PACHET .5vs .GetSDEYersionidata);

MessapeBox .Show(PACHET MISC WideString{data));

- ﬂwdﬁ

Tips & Warnings

A The “PACNET” of “using PACNET” is case- sensitive.
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4.3.5. Upload the application to WP-8000-CE7

WP-8000-CE7 supports FTP server service. You can upload files to WP-8000-CE7 or download files
from a public FTP server.

Step 1: On the Build menu, and then click Build [Project Name]

File Edit View Project |Build | Debug Data Format Tools Test Window Help
Build Solution F7
Rebuild Solution  Ctrl+Alt+F7

Deploy Solution
Clean Solution
## Build SDK_Info
Rebuild SDK_Info
Deploy SDK_Info
Clean SDK_Info

Configuration Manager...
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Step 2: Open the browser and type the IP address of WP-8000-CE7

Step 3: Upload the application and the corresponding PACNET.dII files to WP-8000-CE7

Tips & Warnings

A For applications programming in C# and VB.net with .net compact
framework, when executing these application on WP-8000-CE7, the

corresponding PACNET.dIl must be in the same directory as the .exe file.

| File Edit View Go Favorites ||”J|£
”]Agldress | YTemp

= O

PACMET SDK_Info

R/\U/v‘“"\

N N YA
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4.3.6. Execute the application on WP-8000-CE7

After uploading the application to WP-8000-CE7, you can just double-click it on WP-8000-CE7 to

execute it.

SDK_Info | Check the SOK Yersion | W
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4.4. First WP-8000-CE7 Program in Visual C++

The best way to learn programming with WP-8000-CE7 is to actually create a WP-8000-CE7

program.

The example below demonstrates how to create a demo program running on WP-8000-CE7 with
Visual C++.

To create a demo program with Visual C# that includes the following main steps:

1. Create a new project

2. Configure the Platform

3. Include the Header files and Libraries of the PAC SDK
4. Add the control to the form

5. Add the event handling for the control

6. Upload the application to WP-8000-CE7

7. Execute the application on WP-8000-CE7

All main steps will be described in the following subsection.

In this tutorial, we will assume that you have installed WP-8000-CE7 SDK on PC and used the Visual
Studio 2008 for application development.
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4.4.1. Create a new project

The Visual C# project template is a composite control that you use in this example creates a new
project with this user control.

Step 1: Start Visual Studio 2008

"2

Step 2: On the File menu, point to New, and then click Project

File | Edit View Tools Test Window Help

New » o] Project. Ctrl+Shift+N
| Open » | @  WebSite.. Shift+Alt+N
Close ' | File.. Ctrl+N

7] | Close Solution Project From Existing Code...

7 | Save Selected Items  Ctrl+5S
Save Selected Items As...

@ SaveAll Ctrl+Shift+S
Export Template..

Lt | Page Setup...

4 | Print... Ctrl+P
Recent Files 2
Recent Projects »
Exit
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Step 3: In the Project types pane, expand Visual C++ node and select Smart Device

Step 4: In the list of Templates, select MFC Smart Device Application

Step 5: Specify a name and a location for the application and then click OK

New Project i S — - M

Project types: Templates: NET Framework 3.5 ~ ]
Visual C++ Visual Studio installed templates
ATL @ATL Smart Device Project +i# MFC Smart Device ActiveX Control
ELR | E]"MFC Smart Device Application sfl MFC Smart Device DLL
enera

EWinBZ Smart Device Project
My Templates

MFC

Smart Device

Test

Win32
Other Languages
Other Project Types
Test Projects

21d Search Online Templates...

An application for Windows Mobile and other Windows CE-based devices that uses the Microsoft Foundation Class Library

Name: SDK_Infq|
Location: C\Users\Administrator\Documents\Visual Studio 2008\Projects -
Solution Name: SDK_Info Create directory for solution

OK ] l Cancel l
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Step 6: On the first page of the wizard, click Next

; Welcome to the MFC Smart Device Application Wizard
F
Overview These are the current project settings:
Platforms ® Windows Mobile 5.0 Pocket PC SDK Platform

# Single document interface

Application Type
Document Template Strings Click Finish from any window to accept the current settings.

After you create the project, see the project's readme.tu file for information about the project features
and files that are generated.

User Interface Features
Advanced Features

Generated Classes

< Previous |f Next = |[ Finish ” Cancel

Step 7: On the next page of the wizard, select AM335x_WINCE7_SDK to be added to the
project, and then click Next

——== Platforms

Overview Select platform SDKs to be added to the current project.

Platforms
Application Type

Document Template Strings
Installed SDKs: Selected SDKs:
|P0cket PC 2003 AM335x WINCE7_SDK

User Interface Features
Smartphone 2003

Windows Mobile 5.0 Pocket PC SDK
Windows Mobile 5.0 Smartphone S

Advanced Features

Generated Classes

BB

Instruction sets: ARMw4I, ARMv41

’* AM335x_WINCE7_SDK

<Previons” Next > ” Finish ” Cancel ]

L
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Step 8: On the next page of the wizard, select Dialog based, and then click next

Application Type

Overview Application type: Use of MFC:
Platforms © single document () Use MFC in a shared DLL
Application Type @ Dialog based @ Use MFC in a static library

Document Template Strings O Single document with DocList

User Interface Features
+| Document/View architecture support
Advanced Features

Resource language:

|=x (=)

Generated Classes

<Previons” Next = ” Finish ” Cancel

Step 9: On the next page of the wizard, click next

User Interface Features
Overview Command bar:
Platforms ¢ Menus only
Application Type Menus and buttons
Document Template Strings
User Interface Features Status bar
Advanced Features Dialog title:
Generated Classes SDK_Info
<previous || mWet> || Fnish || cancel |
b - - S
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Step 10: On the next page of the wizard, click next

—

Advanced Features

Overview Advanced features:
Platforms U windows Help
Application Type | Printing and print preview

Document Template Strings 4

User Interface Features [ windows sockets

Advanced Features
lumber of files on recent file list:

G ted Cl
enerated Classes

<Previous” Next = H Finish ” Cancel

Step 11: On the next page of the wizard, click Finish

' ™
—
Generated Classes
Overview Generated classes:
Platforms
CSDK_InfoDlg
Application Type
Document Template Strings
User Interface Features -
Class name: h file:
advancediisatiies CSDK_InfoApp [sDK_1nfo.h |
Generated Classes
Base class: cpp file:
CWinApp |SDK_Inf-:-.cp|J |
<previous || 1ed - || Fnish || cancel
g - ~ - A
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4.4.2. Configure the Platform

When developing applications by using Visual C++, you must configure the Platform to indicate
what platform and device you intend to download the application to. Before you deploy your
project, check the platform.

On the Debug configuration toolbar, select Release and select AM335x_WINCE7_SDK(ARMv4I) as

shown in the following illustration.

AR RA=A" N~ A WEE NN R AT ¢ F.Jv_ﬂ b Release vAM335x_\-"|.fINCE?_SvNB

N~
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4.4.3. Specify the Libraries of the PAC SDK

The PAC SDK provides the PACSDK libraries with WP-8000-CE7.
It’s compatible with C++. In order to use a component in your application, you must first add a
reference to it.

Step 1: On the View menu, and then click Property Pages

File Edit | View | Project Build Debug Tools Test Window Help

=y | Solution Explorer Ctrl+Alt+L
) | Bookmark Window Ctrl+K, Ctrl+W
5% | Class View Ctrl+Shift+C
[ & Code Definition Window  Ctrl+Shift+V
=% Object Browser Ctrl+Alt+)
=] | Output Alt+2
E] Property Manager
'@ | Resource View Ctrl+Shift+E
¢ | Toolbox Ctrl+Alt+X
Find Results »
Other Windows »
Toolbars »
= | Full Screen Shift+Alt+Enter
| | Navigate Backward Ctrl+-
& | Navigate Forward Ctrl+Shift+-
Next Task
Previous Task
3] Property Pages
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Step 2: In left pane, click Linker, and then click Input

Step 3: In the right pane, Type PACSDK.lib in the Additional Dependencies item

g

SDK_Info Property Pages a ® » - » a m
Configuration: |Active(Debug) VI Platform: lActive(AM335x_WINCE?_SDK G "] l Configuration Manager... ]
Common Properties Additional Dependencies PACSDK.lib (]
Configuration Properti Ignore All Default Libraries No
General Ignore Specific Library
Debugging Module Definition File
Deployment Add Module to Assembly
C/C++ Embed Managed Resource File
Linker Force Symbol References
General Delay Loaded DLLs
Inqu . Assembly Link Resource
Manifest File
Debugging
System
Optimization
Embedded IDL
Advanced
Command Line
Resources
XML Document Gen
Browse Information
Build Events

Custom Build Step
Authenticode Signir

Additional Dependencies
Specifies additional items to add to the link line (ex: kernel32.lib); configuration specific.

[ 0K ” Cancel ] Apply
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4.4.4. Add the control to the form

You can drag various controls from the Toolbox onto the form. These controls are not really "live";

they are just images that are convenient to move around on the form into a precise location.
After you add a control to your form, you can use the Properties window to set its properties, such

as background color and default text. The values that you specify in the Properties window are the
initial values that will be assigned to that property when the control is created at run time.

Step 1: On the View menu, and then click Resource View

File Edit | View | Project Build Debug Tools Test Window Help

[z] | Code Ctrl+Alt+0
L‘-‘j Solution Explorer Ctrl+Alt+L
) | Bookmark Window Ctrl+K, Ctrl+W
2% | Class View Ctrl+Shift+C
_ & Code Definition Window  Ctrl+Shift+V
9 Object Browser Ctrl+Alt+)
=] | Output Alt+2
L,:_:l| Property Manager
'@ Resource View Ctrl+Shift+E
¢ | Toolbox Ctrl+Alt+X
Find Results »
Other Windows »
Toolbars >
3 | Full Screen Shift+Alt+Enter
= | Navigate Backward Ctrl+-
=, | Navigate Forward Ctrl+Shift+-
Next Task
Previous Task
Property Pages
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Step 2: In the Resource View Panel, Expand the [Project name].rc file and then expand
the Dialog item to click the plug-in dialog

Resource View - SDK Info w I1 X
=-izd SDK_Info
=-£3 SDK_Info.rc

&-£3 Dialog
JE==S11DD_SDK_INFO_DIALOG - ‘\/

=& Icon _SDK Info.rc - IDD.S... - Dialog| - X
&3 Version 5 3
T T T T R I T T T T R T T S T B R TR |

- Ll u

m-] SDK_Info (=]

~

TODO: Flace dislog controls here,

< | 1 | E
Resource... |3 Toolbox [ Propert

Lo

Step 3: On the Toolbox panel, drag a Button control onto the form

Toolbox + 1 X
B Dialog Editor -
k Pointer r|
||:I Button

¥ Check Box
abl Edit Control
Ef Combo Box
EH List Box ’
(] Group Box | SDK Info [=]
% Radio Button _—-']
Aa Static Text i n " "

Picture Control - "

"_SDK_Info.rc - IDD_S... - Dialog v X
u...|....|....|....|....d

A Ll [N)

B Horizontal Scroll Bar Z TODO: Plare dislog controls here,
B Vertical Scroll Bar
4= Slider Control 4

+1.Toolbox [ Property .

Resource...

L.
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Step 4: On the Properties panel, type Check the SDK version in the Caption field

Properties - 1 X
IDC_BUTTONI (Button Control) ICeButtonEc -
2=]41 &) # | E

E Appearance
Caption Check the SDK version
Client Edge False
Horizontal Alignmer Default
Modal Frame False
Multiline False
Notify False
Static Edge False
Vertical Alignment Default
E Behavior
Default Button False
Disabled False
Owner Draw False
Visible True
E Misc
(Name) IDC_BUTTOM1 (Button C

rou WWW
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4.4.5. Add the event handling for the control

You have finished the design stage of your application and are at the point when you can start
adding some code to provide the program's functionality.

Step 1: Double-click the button on the form

| | SDK_Info 53

u || |
s Checkthe SDE vesion  |m
] [ ] ]

TODD: Flace dialog controls here,

Step 2: Inserting the following code
char sdk_version[32];
TCHAR buf[32];
pac_GetSDKVersion(sdk_version);
pac_AnsiToWideString(sdk_version, buf);

MessageBox(buf,0,MB_OK);

Y YV e N i IV VAN

Hwvoid CSDE InfaoDllg::0nBaClickedButtonl()
{

\J

HfOTODD: Add wour control notification handler code here
char sdk_version[3Z2];

TCHAR buf[3Z2];

pac_GetSDEVersionisdl wersion);
pac_hAns1ToWideString{sdk_version,buf);
MessageBox (huf ,0,MB_OK);

\u_m'-....uuf \b"’ J v

}
Hhkgumwnu”“J“gfrﬂFﬁﬂxxFug”’”““\ujfwwxv““nhfvfw“”“\fh“”‘ﬂvv=—f
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Step 2: Inserting the following code into the header area

#tinclude “PACSDK.h”

B/f SDE_Infallg.cpp @ tmplementation filé}
H y
N n n g
#include "stdafx.h
Finclude "SDE _Infa.k" <;
#Finclude "SDE Infallz. B ¢
#Finclode "PACSDE.L" fE;
S#i1fdef _DEBUG
ﬁww%;w
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4.4.6. Upload the application to WP-8000-CE7

WP-8000-CE7 supports FTP server service. You can upload files to WP-8000-CE7 or download files
from a public FTP server.

Step 1: On the Build menu, and then click Build [Project Name]

File Edit View ijectm Debug Tools Test Window Help
Build Solution F7
Rebuild Solution  Ctrl+Alt+F7
Deploy Solution

Clean Solution
#¥ Build SDK _Info
Rebuild SDK_Info
Deploy SDK_Info
Clean SDK_Info

Project Only »
Batch Build...
Configuration Manager...
% | Compile Ctrl+F7
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Step 2: Open the browser and type the IP address of WP-8000-CE7

Step 3: Upload the application to WP-8000-CE7

Ble Edit View Go Favorites | [['&
llagdress vremrp g/

m S

SOK_Info
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4.4.7. Execute the application on WP-8000-CE7

After uploading the application to WP-8000-CE7, you can just double-click it on WP-8000-CE7 to

execute it.

& | Check the SDK VYersion | W

SDK_Info
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5. 1/0 Expansion Modules and SDKs Selection

This chapter describes how to select a suitable expansion I/O module and the corresponding SDK

library to be used for developing programs on WP-8000-CE7.

WP-8000-CE7 provides the following I/O expansion buses:

M-7K I-7K RU-87Pn

' 1-8172W
FRnet series I/O modules

-8120
, | @ canBus
) ke

CAN Bus series I/O modules

ET-7K ET-87P

[-8K/1-87K series I/O modules
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1. RS-485

[-7000, M-7000, RU-87Pn and high profile 1-87K series modules connect to WP-8000-CE7 via a

twisted-pair, multi-drop, 2-wire RS-485 network.

> 17000 series /0 module

Module Native SDK .NET CF SDK

I-7000 series PACSDK.dII PACNET.dII

I-7000 series with -7088 (D) PACSDK_PWM.dII PACNET.dII

For full details regarding 1-7000 series I/0O modules and its demos, please refer to:
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-8x2x/pac/applicabled demo for 7k module.p
df

» M-7000 series 1/0 module

Module Native SDK .NET CF SDK

M-7000 series Modbus Demo Modbus Demo

For more detailed information about M-7000 series modules using Modbus protocol and its demos,
please refer to:
CD:\WinPAC_AM335x\Wp-8x2x\demo\nModbus\

> RU-87Pn + 1-87K series 1/0O module

Module Native SDK .NET CF SDK

RU-87Pn+I-87K series PACSDK.dII PACNET.dII

» Other Specified 1/0

Module Native SDK .NET CF SDK

Others PACSDK.dII PACNET.dII
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/pac/applicabled_demo_for_7k_module.pdf
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/pac/applicabled_demo_for_7k_module.pdf

2. Ethernet

The Ethernet I/O devices available include ET-7000and I-8KE4/8-MTCP, and support either the
DCON or the Modbus/TCP communication protocol.

Module Native SDK .NET CF SDK
M-7000 series Modbus Demo Modbus Demo
I-8KE4/8-MTCP Modbus Demo Modbus Demo

For more detailed information about ET-7000 and |-8KE4/8-MTCP series modules using
Modbus protocol and its demos, please refer to:
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/demo/nmodbus/

3. Local 1/O

WP-8000-CE7 has 1/4/8 expansion slots that can be used to add expansion I/O modules. The
expansion I/0 modules can be divided into two categories: High Profile I-8K series I/0 modules and
High profile I-87K series I/O modules. The following indicates the appropriate SDK library to be

used for I/O modules.

> General 1-8K/I-87K series 1/O module

Module Native SDK H .NET CF SDK
I-8K series PACSDK.dII PACNET.dII
I-87K series PACSDK.dII PACNET.dII
I-8K series with PWM PACSDK_PWM.dII PACNET.dII
I-87K series with PWM PACSDK_PWM.dII PACNET.dII

For full details regarding 1-87K series I/0O modules and its demos, please refer to:
http://ftp.icpdas.com/pub/cd/winpac am335x/wp-8x2x/pac/applicabled demo for 87k module.

pdf
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/pac/applicabled_demo_for_87k_module.pdf
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/pac/applicabled_demo_for_87k_module.pdf

» Other Specified 1/0

Module Native SDK ‘ .NET CF SDK

1-8014W pac_i8014W.dll pac_i8014WNET.dII
I-8017HW pac_i8017HW.dII pac_i8017HWNET.dII
1-8024W pac_i8024W.dll pac_i8024WNET.dII
I-8026W pac_i8026W.dII pac_i8026 WNET.dII
I-8048W pac_i8048W.dlI pac_i8048WNET.dII
I-8050W pac_i8050W.dlI pac_i8050WNET.dII
1-8084W pac_i8084W.dlI pac_i8084WNET.dII
I-8088W pac_i8088W.dlI pac_i8088WNET.dII
1-8093W pac_i8093W.dlI pac_i8093WNET.dII
[-87088W PACSDK_PWM.dII PACNET.dII

4. FRnet

FRnet is an innovative industrial field bus technology that uses twisted pair cable as the
transmission medium. The status of all I/O devices is updated on a fixed cycle, no matter how

many FRnet I/O modules are connected to the FRnet network.

Module Native SDK .NET CF SDK

-8172W pac_i8172W.lib pac8172WNet.dll

5. CAN Bus

The Controller Area Network (CAN) is a serial communication way, which efficiently supports
distributed real-time control with a very high level of security. It provides the error-processing
mechanisms and concepts of message priority. These features can improve the network reliability
and transmission efficiency.

Module Native SDK ‘ .NET CF SDK
‘ -8120W ‘ i8120.lib ‘ i8120net_pac.dll ‘
WP-8000-CE7 Series User Manual, version 1.0.2 Page: 108

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com



6. APl Resources and Demo References

This chapter provides a brief overview of PAC standard APIs and demos that have been designed
for WP-8000-CE7 from the PAC SDK package.

ICP DAS provides a set of demos in different programming languages. You can examine the demo
codes, which includes numerous comments, to familiarize yourself with the PAC APIs. This will

allow developing your own applications quickly by modifying these demo programs.

For full usage information regarding the description, prototype and the arguments of the functions,
please refer to the “PAC Standard APl Manual”

78 PAC Standard API Manual 1.1.1.pdf - Adobe Actobat Pro CExX
WRE REE RN \JEW A *®
Ber- | RO EORPE| govblh &0 57 - | i
D@ o) [N |=@ | A EE ER
L)|== Bl 2. PAC API Functions .
‘EP E- B R
: =[P 2.1, System Information API i’ - m I} |
g EF 2.1.1, pac_GetModuleMame
I pac_GetRotaryiD = EF 2.1, System Information API -
Iél_‘,léf [P 2.1.3, pac_GetSerialNumber
Pa1a pac_GetsShKversion G 2.1.1. pac_GeﬂWDduleName
EF 2.1.5. pac_ChangeSiot
[F 2.1.6, pac_CheckSDK\Version E paE—GEtRDtarYID
gii; "ac-z'Dg‘E'iE"‘s_“s [P 2.1.3. pac_cetSerialNumber E
L8, pac_Ge Brsion
52‘1-9 pac_GetvacAddress EP 2.1.4, pac_GetsDENersion
2,110, pac_ReBoot
[P 2.1.11. Pac_GetCFUVersion E 2.1.5. pac_ChangeSlot
[P 2.1.12. Pac_EnableLED .
[P 2,115, Pac_crableLDs EP 2.1.6. pac_CheckSDK\ersion
52‘1.14. pac_Back\';vardCDmpatlble E 2.1.7. [JaE_MDdU'EE}{iStE
2.1.15. pac_GetFhootversion
[P 2116, pac_cetcommapning EF 2.1.8. paE_GetDSH-’ErSiDn
[P 2.1.17. pac_GetvoduleT
P 2115, o _cetFacsitvsin [F' 2.1.9. pac_GetMacaddress
Ez‘l.lg. pac_PuzzerBeep - E =910, pac_ReE-DDt v

[ 2.1.11. Pac_getcPUversion

[P 2.1.12. Pac_EnableLED

[P 2.1.13. Pac_EnablelEDs

[P 2.1.14. pac_BackwardCormpatible
EP 2.1.15. pac_GetEhootersion

[P 2.1.16. pac_GetcomMapping

[P 2117 pac_GetvoduleType

EF 2.1.18. pac_ietPacNetversion

EF 2.1,19. pac_BPuzzerBeep
(il
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6.1. PAC Standard APIs for System Operation

The diagram below shows the set of each system operation API provided in the PACSDK.

|
| [ » System Information » Watchdog
| | » Backplane Access >» UART

» Backlight » Registry

>» Interrupt » Buzzer

» Memory Access >» LED

System Operation
Tel
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6.1.1. VB.NET Demos for PAC Standard APIs

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a
VB.NET language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.
CD:\WinPAC_AM335x\wp-8x2x\demo\PAC\Vb.net\Standard\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/demo/pac/vb.net/standard/

buzzer buzzer Shows how to make a simple buzzer beep.
) ) ) ) Retrieves information about the OS version, CPU
Devicelnformation Devicelnformation ) )
version, SDK version, etc.
Retrieves information about the status of the
GetRotaryIlD GetRotaryIlD )
rotary switch
Shows how to read/write data values from/to
Memory Memory
the EEPROM or the backplane of the SRAM
MicroSD MicroSD Shows how to manage the microSD
Writes the managed code for the rich graphical
RealTimeTest RealTimeTest user interface that does not require true
real-time performance
) ) Shows how to read/write data values from/to
Registry Registry .
the registry
Shows how to read the name of a local I/O
UART UART )
modules via a UART
Displays information about how to operate the
WatchDog WatchDog
watchdog
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6.1.2. C# Demos for PAC Standard APIs

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a
C# language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.
CD:\WinPAC_AM335x\wp-8x2x\demo\PAC\C#\Standard\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/demo/pac/c%23/standard/

buzzer buzzer Shows how to make a simple buzzer beep.
) ) ) ) Retrieves information about the OS version, CPU
Devicelnformation Devicelnformation ) )
version, SDK version, etc.
Retrieves information about the status of the
GetRotaryIlD GetRotaryIlD )

rotary switch
Shows how to read/write data values from/to

Memory Memory
the EEPROM or the backplane of the SRAM

MicroSD MicroSD Shows how to manage the microSD
Writes the managed code for the rich graphical

RealTimeTest RealTimeTest user interface that does not require true
real-time performance
) ) Shows how to read/write data values from/to

Registry Registry .
the registry
Shows how to read the name of a local I/O

UART UART )
modules via a UART
Displays information about how to operate the
WatchDog WatchDog
watchdog
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6.1.3. Visual C++ Demos for PAC Standard APIs

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a
Visual C++ language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.
CD:\WinPAC_AM335x\wp-8x2x\demo\PAC\Vc2008\Standard\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/demo/pac/vc2008/standard/

buzzer buzzer Shows how to make a simple buzzer beep.
) ) ) ) Retrieves information about the OS version, CPU
Devicelnformation Devicelnformation ) )
version, SDK version, etc.
Retrieves information about the status of the
GetRotaryIlD GetRotaryIlD )
rotary switch
Shows how to read/write data values from/to
Memory Memory
the EEPROM or the backplane of the SRAM
MicroSD MicroSD Shows how to manage the microSD
Writes the managed code for the rich graphical
RealTimeTest RealTimeTest user interface that does not require true
real-time performance
) ) Shows how to read/write data values from/to
Registry Registry .
the registry
Shows how to read the name of a local I/O
UART UART )
modules via a UART
Displays information about how to operate the
WatchDog WatchDog
watchdog
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6.2. PAC Standard APIs for PAC Expansion 1/O

The diagram below shows the types of the PAC 10 APIs provided in the PACSDK.
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6.2.1. VB.NET Demos for PAC Expansion I/O

The PAC SDK includes the following demos that demonstrate the use of the PAC expansion I/O in a
VB.NET language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.
CD:\WinPAC_AM335x\wp-8x2x\Demo\PAC\Vb.net\IO\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/demo/pac/vb.net/io/

Folder Demo ‘ Explanation

Shows how to retrieve the module names and types which
plugged in the WinPAC.

Shows how to read the DI values of DI module.

find_io

8k_di
- This demo program is used by 8K series DI modules.

gk d Shows how to write the DO values to DO module.
o

- This demo program is used by 8K series DO modules.

Shows how to read the DI and the DO values of the DIO

8k_dio module.

This demo program is used by 8K series DIO modules.

o et Shows how to send/receive a command/response application.
asic
- This demo program is used by 87K series modules.

Shows how use uart APl and the |0 modules located as slots.
Local 87K_demo ] ] ]
This demo program is used by 87K series modules.

— Shows how to read the Al values of Al module.
ai
- This demo program is used by 87K series Al modules.

87k Shows how to write the AO values to AO module.
ao
- This demo program is used by 87K series AO modules.

e of Shows how to read the DI values of DI module.
i
- This demo program is used by 87K series DI modules.

87k do Shows how to write the DO values to DO module.
- This demo program is used by 87K series DO modules.
Shows how to read the DI and the DO values of the
87k_dio DIO module.

This demo program is used by 87K series DIO modules.

Shows how to send/receive a command/response application.

Remote 7k87k_basic This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
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Folder Demo ‘ Explanation

Shows how to read the Al values of Al module.
7k87k_ai This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to write the AO values to AO module.
7k87k_ao This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to read the DI values of DI module.

- . 7k87k_di This demo program is used by 7K or 87K series
emote
Al modules which connected through a COM port.

Shows how to write the DO values to DO module.
7k87k_do This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
Shows how to read the DI and the DO values of the DIO
module.

7k87k_dio
This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
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6.2.2. C# Demos for PAC Expansion I/O

The PAC SDK includes the following demos that demonstrate the use of the PAC expansion I/O in a

C# language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.
CD:\WinPAC_AM335x\wp-8x2x\Demo\PAC\C#\I0\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/demo/pac/c%23/io/

Folder Demo ‘ Explanation

Shows how to retrieve the module names and types which
plugged in the WinPAC.

Shows how to read the DI values of DI module.

find_io

8k_di
- This demo program is used by 8K series DI modules.

gk d Shows how to write the DO values to DO module.
o

- This demo program is used by 8K series DO modules.

Shows how to read the DI and the DO values of the DIO

8k_dio module.

This demo program is used by 8K series DIO modules.

o et Shows how to send/receive a command/response application.
asic
- This demo program is used by 87K series modules.

Shows how use uart APl and the |0 modules located as slots.
Local 87K_demo ] ) ]
This demo program is used by 87K series modules.

— Shows how to read the Al values of Al module.
ai
- This demo program is used by 87K series Al modules.

87k Shows how to write the AO values to AO module.
ao
- This demo program is used by 87K series AO modules.

e of Shows how to read the DI values of DI module.
i
- This demo program is used by 87K series DI modules.

87k do Shows how to write the DO values to DO module.
- This demo program is used by 87K series DO modules.
Shows how to read the DI and the DO values of the
87k_dio DIO module.

This demo program is used by 87K series DIO modules.

Shows how to send/receive a command/response application.

Remote 7k87k_basic This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
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Folder Demo ‘ Explanation

Shows how to read the Al values of Al module.
7k87k_ai This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to write the AO values to AO module.
7k87k_ao This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to read the DI values of DI module.

- . 7k87k_di This demo program is used by 7K or 87K series
emote
Al modules which connected through a COM port.

Shows how to write the DO values to DO module.
7k87k_do This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
Shows how to read the DI and the DO values of the DIO
module.

7k87k_dio
This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
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6.2.3. Visual C++ Demos for PAC Expansion I/O

The PAC SDK includes the following demos that demonstrate the use of the PAC expansion I/O in a

C# language environment.

The following demos can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.
CD:\WinPAC_AM335x\wp-8x2x\Demo\PAC\Vc2008\I0\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/demo/pac/vc2008/io/

Folder Demo ‘ Explanation

Shows how to retrieve the module names and types which
plugged in the WinPAC.

Shows how to read the DI values of DI module.

find_io

8k_di
- This demo program is used by 8K series DI modules.

gk d Shows how to write the DO values to DO module.
o

- This demo program is used by 8K series DO modules.

Shows how to read the DI and the DO values of the DIO

8k_dio module.

This demo program is used by 8K series DIO modules.

o et Shows how to send/receive a command/response application.
asic
- This demo program is used by 87K series modules.

Shows how use uart APl and the |0 modules located as slots.
Local 87K_demo ] ) ]
This demo program is used by 87K series modules.

— Shows how to read the Al values of Al module.
ai
- This demo program is used by 87K series Al modules.

87k Shows how to write the AO values to AO module.
ao
- This demo program is used by 87K series AO modules.

e of Shows how to read the DI values of DI module.
i
- This demo program is used by 87K series DI modules.

87k do Shows how to write the DO values to DO module.
- This demo program is used by 87K series DO modules.
Shows how to read the DI and the DO values of the
87k_dio DIO module.

This demo program is used by 87K series DIO modules.

Shows how to send/receive a command/response application.

Remote 7k87k_basic This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
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Folder Demo ‘ Explanation

Shows how to read the Al values of Al module.
7k87k_ai This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to write the AO values to AO module.
7k87k_ao This demo program is used by 7K or 87K series
Al modules which connected through a COM port.

Shows how to read the DI values of DI module.

- . 7k87k_di This demo program is used by 7K or 87K series
emote
Al modules which connected through a COM port.

Shows how to write the DO values to DO module.
7k87k_do This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
Shows how to read the DI and the DO values of the DIO
module.

7k87k_dio
This demo program is used by 7K or 87K series

Al modules which connected through a COM port.
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7. WP-8000-CE7 Updates

This chapter provides a guided tour that demonstrates the steps needed to update the
WP-8000-CE7 OS and SDKs.

ICP DAS will continue to add additional features to WP-8000-CE7 SDK and OS in the future, so we
advise you to periodically check the ICP DAS web site for the latest updates.

The file location of the OS and SDK
Both the files of OS updates and SDK updates can be found on the CD that was provided with the

package or by downloading the latest version from ICP DAS web site.

CD:\WinPAC_AM335x\wp-8x2x\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/

OS_Image

> The files of OS updates

update_from_Micro_SD

update_from_file e ‘

> The files of SDK updates

PlatformSDK |
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7.1. OS Updates

The latest version of the WP-8000-CE7 OS image can be found separately on the CD that was

provided with the package or by downloading the latest version from ICP DAS web site.

CD:\WinPAC_AM335x\wp-8x2x\0S_Image\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/os_image/

update_from_Eshell_or_Micro_SD

e update_from_file

There are two ways to update the OS:

0OS image

OS updates from
Eshell

OS updates from
microSD

1. OS updates from Eshell (Please refer to section 7.1.1)
(We recommend that you use this one for more quicker and easier to update)

2. OS updates from microSD (Please refer to section 7.1.2)
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7.1.1. OS Updates from Eshell

By default, the OS update is updated via a LAN.
Before updating the OS, make sure the LAN is
connected to PC.

Step 1: Get the latest version of the installation package file and then unzip it
The latest version of the installation package file can be found from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-8x2x/os image/update from esh

ell or micro sd\

Step 2: Run the registry clear.exe

The registry.exe can be found on the CD that was provided with the package or by
downloading the latest version from ICP DAS web site.

CD:\WinPAC_AM335x\WP-8x2x\PC_Tools\Eshell

http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/pc tools/eshell

Step 3: Place the rotary switch in position 3, OS update mode
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/os_image/update_from_eshell_or_micro_sd/
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Step 4: Run the ESHELL.exe, and then restart the WP-8000-CE7-CE7

The ESHELL.exe can be found on the CD that was provided with the
package or by downloading the latest version from ICP DAS web site. ESHELL

CD:\WinPAC_AM335x\WP-8x2x\PC_Tools\Eshell

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-8x2x/pc tools/eshell

Step 5: Select the device which you want to update the OS image, and then click OK

Select the device name which you want to update the OS image from the list.

Select Device

Enter Device Mame:

[WINPAC

Cancel

i,

Or Select Fram the List

Reset devices to
automatically put
names on the
izt

Step 6: Select the latest version of the OS image file

Look inc | (£ WPtha S0 s | A04_ml

~:. U NE binf
R A
My Recent

[hocuments

- W5 e Wosdews O Tabag Flelll - TF_S5000 ARl TNl Disaged oolery 00 _co MO0 _imape'wy 20w 1w 2 ||
— [ Bl ook fdoes Yew fey

Deskiop B &F A ': |
OF_NANRE | BEEIasaer Berulias 0,0, IFD 191,050, MRC; BReETF ek

=

Srwnleading " ViR avod_ PVHaFE0 napdastvp - T E_crt NS imegeep - FluTapdate_fron_[nbe 1m0

| Linplag) Lo Lnage s F_WAAPE _..
.----"III |fonnrining e oF_skadl eiing lll-h'l-rl:

My Drocurments
My Computes i 3
File NE BIN

Files of types: NK Images (*
B EEEEE———
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Step 7: Once the procedure is completed, the “Warning !” dialog box will appear as
below shown, then turn the rotary switch in position 0, normal mode

YWarning

"'_n.. Reboot this device right nowy |
L Flease turn the rotary switch to 0 - normal

Step 8: Click the OK button

¥arning
"'_n,‘ Reboot this device right nowy |
L Flease turn the rotary switch to 0 - normal

Step 9: Check the OS version

Run the PAC Utility, and then select the Device Information tab to check the current

OS version.
X
A \
PAC_Utility
PAC Utility [1.2.1.4] |0
[General I General2 IDispIay I IF Config INetwork |DewceInf0rmat|Dn| Auto Execution I Fotary EXML
Slot 1: |:| Module(CPU) Type: | |
Stz [ ] Serial Number: [p1-82-4D-06-18-00-00-D8 |
Slot 3: l:l Backplane Yersion: | |
Slot 4: |:| CPU Yersion: [tooa |
Slot 5: |:| 05 Yersion: [10.11, 2msa0m0 09536 |
Sote: [ ]  Ebootversion: [12.10, 2msa0/22 16:260 |
Slot 7: |:| {NET CF Yarsion: |2.5.7238.00 |
SOL CE version: [35.8154.0 |
PACSDK Version: [4.2.34 |
CPU Temperature: | |
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7.1.2. OS updates from microSD

The microSD card can be used to reinstall the WP-8000-CE7 OS image to factory default settings in
the event of the WP-8000-CE7 failure.

Step 1: Get the latest version of the installation package file, then unzip the file, and then
copy them to microSD card

The latest version of the installation package file can be found from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-8x2x/os image/update from esh

ell or micro sd\

& WP523x 20140821 Ver.1.0.0.4 ml

File Edit “ew Favortes Tools Help

eBack - J lg; /:] Search I Folders =Y o

acidress |3 Ciupdate_from_Eshell_or_Micro_STAWPS23x_20140821

EBOOTHD abd] EBOOTSD b0

WBOHE | HED %
i 156 KB i 256 KB

MLO

deoin

XLDRSD nbd
NEQ %
2331 24Kp

Adapter

Step 2: Plug the microSD card into SD slot

A

icro
m<eS

Adapter
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Step 3: Turn the rotary switch in position 5,
OS update mode

PAC Utility [1.2.1.4]

iﬁﬁ Help

Save %r

Save and Reboot pnfig | Netwark 37

Step 4: Reboot the WP-8000-CE7 Reboot 4
)

Restare Utility Default Settings 1’3

Exit _{’)

AC UtiP

T

Step 5: Wait a few minutes for the following
desktop to be displayed

Step 6: Turn the rotary switch in position 0, normal
mode
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Step 7: Reboot the WP-8000-CE7

PAC Utility [1.2.1.4]

iﬁE Help

-

i
Save %‘l’
Save and Reboot £l | EEE 7

Reboot

Restore Utility Default Settings
Exit

Step 8: Check the OS version

J U%’J\u“‘""#“\

Run the PAC Utility, and then select the Device Information tab to check the current

OS version.

PAC_Utility ‘

M [=] B3

PAC Utility [1.2.1.4]

File Help

Slot 1:
Slot 2:
Slot 3:
Slot 4:
Slot 5:
Slot 6:

Slot 7:

Serial Mumber:

CPU Yersion:
05 Version:

Eboot Yersion:

UL

MET CF Yersion:
SOL CE Yersion:

PACSDE Yersion:

CPU Temperature:

Maodule(CPL) Type:

Backplane Version:

|
|o1-62-4p-06-18-00-00-D8. |
| |

|

[tooa

[10.1.1, 2015/10/30 09:365 |

[12.1.0, 201540722 16:26:0 |

[35.7338.00 |

[35.8154.0

|
[433.4 |
|
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7.2. SDK Updates

SDK update is a part of the WP-8000-CE7 update services to provide additional and more efficient
features and functionality for WP-8000-CE7 operating system.

The SDK update files can be found separately on the CD that was provided with the package or by

downloading the latest version from ICP DAS web site.

CD:\WinPAC_AM335x\wp-8x2x\SDK\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/sdk/

— ST
- T
— ST
ST
B amsor
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7.2.1. SDK Updates for VB.NET or C#

The SDK can be updated by changing the SDK file.

Step 1: Get the latest version of the PACNET.dII file

The latest version of the PACNET.dII file can be obtained from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-8x2x/sdk/pacnet/

Step 2: Copy the latest version of PACNet.dll file to PC and WP-8000-CE7
The PACNET.dII file on PC can be placed anywhere only the solution can reference it.

The PACNET.dII file on WP-8000-CE7 is located at the same directory as the .exe file.
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-8x2x/sdk/pacnet/

7.2.2. SDK Updates for VB.NET or Visual C++

The SDK can be updated by changing the SDK file.

Step 1: Get the latest version of the VC++ components
The latest version of the VC++ components can be obtained from:

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-8x2x/sdk/pacsdk/

Step 2: Copy the latest version of header files and libraries to PC
The header files are located at:
C:\Program Files\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\Include\Armv4i
The libraries are located at:

C:\Program Files\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\Lib\ARMv4|

Step 3: Copy the latest version of DLL files to WinPAC
The DLL files are located at:

\System_Disk\ICPDAS\System
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8. Download Center

This chapter provides a brief introduction of the WP-8000-CE7 download center.

WP-8000-CE7 has a download center where you can access the latest version of the software, tools,

demo programs, and related information.

The WP-8000-CE7 Download Center can be found at:
http://www.icpdas.com/root/support/download/pac/wp-8000-ce7/wp-8000-ce7 download os i

mages.html

WP-8000-CE7 Download Center

Note:

When vou download the software programs, you should notice if the programs conform to your
machine. Before yvou download any program, plezse read the notes of each online program first to
avoid the confusad situation.

e Ty

05 images ( SDK Tutilit‘,r & To-nIsT Demo T Documents TS'_.rstem DiskT FAQ

Mote:
Before you download the software programs, you should notice if the programs are compatible to
wour machine. Please read the notes first in each chapter you want before downlozd programs.

Touch Panel driver
WP-B000-CE? provide drivers of PenMount, and ELO touch panels (USB/RS-232). Please download

the driver(s) to vour WinPAC and double-click it to install the driver.

Touch Panel driver download

Support type Model

PenMount USE TOUCH ADP-10B0T-L

PenMount Serizl TOUCH ADP-1080T-R

ELO USE TOUCH ELO USB touch panel
ELO Serial TOUCH ELO RS-232 touch panel

L TN e T T e T
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Tips — How to

This chapter provides tips and a guided tour on using and maintaining the WP-8000-CE7.

WP-8000-CE7 Series User Manual, version 1.0.2 Page: 133

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com




A. How to Online Debug the WP-8000-CE7 Program

Here are step by step instructions on how to online debug the WP-8000-CE7 program.

Tips & Warnings

A\

Before starting online debug the WP-8000-CE7 program, make sure that the
WP-8000-CE7 SDK has been installed correctly.

For more information on how to install the WP-8000-CE7 SDK, please refer

to 4.1.2. Installing the WP-8000-CE7 SDK.

Step 1: Copy the following files to the \System_Disk\icpdas\system on the WP-8000-CE7

By default, these files are located on the development computer at C:\Program

Files\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\<CPU>.

clientshutdown.exe

CMAccept.exe

ConmanClient2.exe

eDbgTL.dll

TcpConnectionA.dll

Step 2: Run the ConmanClient2.exe and then CMAccept.exe on the WP-8000-CE7

mfc20ipn

pacnet

L)

atlso

)

rnfcB0kor

)

mfc90ita

)

pacsdk

I]]ﬂgldrezs | WSystermn_Diskicpdasisysten

fie

autoinit

mfc90jpn

)

pacsdk_wm

@] (%
mfcB0chs  mfcB0cht
@) (%
mfc80ud  mfc90chs
@] (%
rfc90kar rnfc90u
Iy

eDbgTL

Nt TN NS T
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mfc20den

)

rnfc0cht

)

mfc20ud

L)

mfc20enu

)

mifc90dew

|

mfc20esp

)

rnfcS0eru
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Step 3: On the Tools menu, click the Options

File Edit View Project Build Debug Test Window Help

A RgtERgr=4" N- N REERR Y

: AM335x WINCE7_SDK AF v | 85 @ | 42

t ACR ot AT o e

Attach to Process... Ctrl+Alt+P

Device Security Manager...

Connect to Device...

~Device By o NARager N/ s
I e

External Tools...

Import and Export Settings...

Step 4: In the left pane, expand Device Tools node and select Devices

Step 5: In the Show devices for platform:, select AM335x_WINCE7_SDK and then click

Properties

Options

Environment

Projects and Solutions
Source Control

Text Editor
Database Tools
Debugging
Device Tools
General
Devices
Form Factors
HTML Designer
Office Tools
Test Tools
Text Templating
Windows Forms Designer

AMI35X WINCE/ _SUin Aiviviv s

LACVILE

A

Workflow Designer
Default device:

AM335x_WINCE7_SDK ARMV7 Device
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Step 6: Click the Configure...

AM335x_WINCE7_SDK ARMV7 Device Properties

Default output location on device:

Transport:

|TCP Connect Transport

Bootstrapper:

|ActiveSync Startup Provider - |

Detect when device is disconnected

Config

Ure...

OK

Cancel

Step 7: Select the Use specific IP address:, and then type the IP address of WP-8000-CE7

Configure TCP/IP Transport
-

=x=)

"] Use fixed port number: 5655

Device IP address

automatically using ActiveSync

@ Use specific IP address:

10.1.0.96|

QK

‘ Cancel
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Step 8: Click the OK, and then click OK to end the dialog

AM335x_WINCE7_SDK ARMV7 Device Properties P

e ——— i o—

Default output location on device:

Transport: i
[TCP Connect Transport v l l Configure... l
Bootstrapper:

[ActiveSync Startup Provider '] ‘ Configure.. ‘

Detect when device is disconnected

Lok ]

Options

> Environment Show devices for platform:
» Projects and Solutions

» Source Control

» Text Editor

» Database Tools

» Debugging

a Device Tools
General Rename...

| AM335x_WINCE7_SDK -

Devices:

AM335x_ WINCE7_SDK ARMV7 Device

Save As...

| Devices|
Form Factors
> HTML Designer :
» Office Tools Properties...
» Test Tools i\
» Text Templating
> Windows Forms Designer |

» Workflow Designer [
Default device:

Delete

il

AM335x_WINCE7_SDK ARMV7 Device w7 l |
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Step 9: On the Tools menu, click the Connect to Device...

File Edit View Project Build Debug |Tools | Test Window Help
%% | Attach to Process.. Ctrl+Alt+P

"Security Manager...
Connect to Device...

Device Emulator Manager...

Connect to Data ase...

Connect to Server...

Code Snippets Manager... Ctrl+K Cirl+B
e T e S e

Step 10: Wait for the connection to be established

.

To 'AM335x WINCE7_SDK ARMV7 Device'
Connection succeeded.

Tips & Warnings

Q If the connection fails, as shown below, please repeat the step 2 to step 9 to
try it again.

E :

To 'AM335x WINCE7_SDK ARMV7 Device'

Connection failed. ActiveSync bootstrap initialization
failed.
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B. How to Automatically Synchronize WP-8000-CE7 Clock with an
Internet Time Server

The clock on the WP-8000-CE7 can be synchronized with an internet time server. This means that
the clock is updated to match the clock on the time server, which can help ensure that the time on
the WP-8000-CE7 is accurate. Here are step by step instructions on how to synchronize the clock
on the WP-8000-CE7 with an Internet time server.

Step 1: Run the PAC Utility

PAC_Utility

Step 2: On the General tab, press Configure button

PAC Utility [1.2.1.4]

File Help

General | General2 I Display IIF' Config I Metwark I Device Information I.-'l'-.ub] Execution I Rotary Exg 4| ¥

Welcome o use PAC Utility
This tool will help you easy o
Lse PAC CE series,

PAC Utilit Y Task Bar setting:
[ suto Hide

[ always On Top

HIVE Reqistry:
) AUt Save Tao Flash (Default)

{ ) Maunal Save Tao Flash

Backplane Battery [7] Enable sutarun in plugging USE Disk
Batteryl : OK Battery2 : OK [] Enable sutarun in plugging Micro SD
RTC Battery

Configure the synchronization with a time seiffer Configure
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Step 3: Select the domain name from the Server drop-down list, and then enter a value
in the Autoupdate Frequency field

Step 4: Check the Automatically synchronize with an internet time server check box

Stepl: Server: I tock, usno.navy., mil El

Step2: autoupdate Freguency:  |20160 | minute

Step3:

Autarnatically synchronize with an internet time server

Lipdats Mow

Step 4:Go to "File" -->"Save and Reboot" 1o enable
driver

ALt update running

Step 5: On the File menu, click Save and Reboot

PAC Utility [1.2.1.4]
F=8 Help

Save and Reboot

Reboot 3
_,."
.

Restore Utility Default Settings -~

Exit 3

Step 6: The WP-8000-CE7 will automatically synchronize with an internet time server

regularly
Stepl: Server: |b:nck.usnn:u.naw.mil El
Step 7: Click the Update Now button to

. Step2: Autoupdate Frequency: 20160 | minute
synchronize WP-8000-CE7 clock .
immediately Be

Cally synchronize with an internet tim

Lipdate Mo

il2" --="Save and Reboot" 1o

driver

Auto update running
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C. How to Control the User Account Control in WP-8000-CE7

User Account Control is a security feature that helps prevent unauthorized system changes to the
WP-8000-CE7.
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C.1. How to Create a User Account

Here are step by step instructions on how to add a user account.

Step 1: Run the PAC Utility

\_/L

PAC_Utility

Step 2: On the Login tab of the Network tab, click Login tab, type the User Name and
Password, and then click Add button

PAC Utility [1.2.2.0] | _|
IGeneraI I General? I Display IIF' Config | Metwork |Device Infor mation I.&uh: Execution IRDtary E}{d 1 I 4
IAccess| Login |
User Mame Password
ficroes N |  4od || Delet
User name I Password I
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Step 3: The user has been added to the allowed under the remote login and included in
the following list

PAC Utility [1.2.2.0] !
File Help

[General IGeneraI2 IDispIa\; IIF' Config | Network |Device Information IAuh: Exerution IRDtary Ex4 i I »

I Access | Login |

Lizer Marmne Password

icP Das | [~ | add || Delete

User name | Password

Step 4: On the File menu, click Save and Reboot for changes to take effect
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C.2. How to Telnet to Remote Login the WinPAC from PC

Here are step by step instructions on how to use telnet to remote login the WinPAC from PC.

Step 1: On the PC, open a MS-DOS command prompt

h SESPREE ST . e R
T wind |
. Windows Catalog

# Windows Update i‘
= 2
‘ z
@ S

Programs »

2 Documents » & Type the 2. Type ”cmd" ent, ar
82 : Internet re for you,
ettings
rid) v

Windows XP Professional

[ OK ] [ Cancel ] [ Browse...

Step 2: At the command prompt, type “telnet (IP address)”

w CAWINDO WS evstem32wmd .exe

C=“Documents and Settingz“MWindows>telnet 168.1.8.31
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Step 3: The connection has been set up, and then type the name and password

o Telnet 10.1.0.31

llelcome to the Windows CE Telnet Service on Compact

login: ICPDAS
Password:

Step 4: The remote login has been completed

cn Telnet 10.1.0.31

Melcome to the Windows CE Telnet Serwvice on Compact

login: ICPDAS
Password:

CMD » 7.088
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C.3. How to Remove a User Account from the Login List

Here are step by step instructions on how to remote the user from the login list.

Step 1: Click a user from the list which you want to remove, and the user will display in
the field, and then press Delete to delete the user from the login list

PAC Utility [1.2.2.0] !

File Help

IGeneraI General2 IDispIay IIP Config | Metwork |Device Infar mation IAum Execution IRotary Exsl 1 I 4

[ Access | LOgin |

User Mame Passwiord
ice Das | [ || add | Dekte
User name | Password

Step 2: On the File menu, click Save and Reboot for changes to take effect
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D. How to change the battery

RTC is retained by a Li-ion battery, which can supply continuous power for 10 years. The battery
design has the added function of preventing data from being lost while replacing the battery. The
following figures show the location of the battery installed in the WinPAC CPU board.

Checking the current battery power

1. Run the PAC utility and check the Battery 1 fields that display the current status. Refer
to Section 3.1 PAC utility “General” for more details. If the power level is low that the
battery should be replaced.

2. When programming this, call the pac_GetBatteryLevel() API function in the PACSDK.dII
to check whether the battery power is low. When the power of the battery is low, it’s
recommended that the battery is replaced immediately, otherwise the RTC time will
be reset.
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Replacing the battery

Power off the WinPAC device.
Remove the CPU board.

Remove the battery that is running low on power from the battery holder in CPU
board.

4. Insert a new battery.
5. Set the RTC time.

Ordering information

Battery type: BR1632 (Part number is 2LB010 for ICP DAS)

For more detailed information, contact your local sales office or distributor.

Tips & Warnings

Q Please ignore the battery on the backplane.

It uses to backward compatible the WP8x4x and WP8x3x device.

Battery 1
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E. How to Using the Practical Functions of the 3G/4G I/O Module

E.1. How to Auto Dial 3G/4G GPRS network and redial when the network
disconnected

The AutoDialer allows user to automatically dial GRPS network after boot.
When the GRPS network disconnect the AutoDialer will automatically re-dial Internet access.

Tips & Warnings

A Before installing the SIM card, please cancel the PIN lock function of SIM
card; otherwise you will not be able to dial the Internet

The demos can be found on the CD that was provided with the package or by downloading the
latest version from ICP DAS web site.
CD:\WinPAC_AM335x\wp-5231\demo\3g_modem\autodialer\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g modem/autodialer/

The description of the demo can be found by downloading the latest version from ICP DAS web
site.

http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/document/fag/development/

W5-13 How_to_use_Auto_dial_GPRS_network_and_redial_when_the_network_disconnected_en
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E.2. How to Use the SMS Function and Get the GPS Data

The 3G/4G modem allows the user to use the SMS function and get the GPS data.

The APl manual can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/demo/3g modem/3g modem sms dem

o/gsm lib manual v1.0.1.pdf

The demos can be found on the CD that was provided with the package or by downloading the
latest version from ICP DAS web site.

CD:\WinPAC_AM335x\Wp-5231\demo\3g_modem \3G_modem_SMS_Demo)\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g modem/3g modem sms dem

o
The description of the demo can be found by downloading the latest version from ICP DAS web
site.

http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/document/fag/development/
W5-14 How_to_use_the SMS_function_and_get the GPS_data_en
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g_modem/3g_modem_sms_demo/gsm_lib_manual_v1.0.1.pdf
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http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g_modem/3g_modem_sms_demo
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g_modem/3g_modem_sms_demo
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/document/faq/development/

E.3. How to Synchronize the System Time by GPS Data

The demos can be found on the CD that was provided with the package or by downloading the
latest version from ICP DAS web site.
CD:\WinPAC_AM335x\Wp-5231\demo\3g_modem\gpstimesynchronization\
http://ftp.icpdas.com/pub/cd/winpac_am335x/wp-5231/demo/3g modem/gpstimesynchronizati

on

The description of the demo can be found by downloading the latest version from ICP DAS web
site.

http://ftp.icpdas.com/pub/cd/winpac am335x/wp-5231/document/faqg/development/

W5-15_How_to_Synchronize_the_system_time_by_GPS_data_en
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F. Application of RS-485 Network

The RS-485 length can be up to 4000 ft or 1.2 km over a single set of twisted—pair cables, if the
RS-485 network is over 4000 ft or 1.2Km, the RS-485 repeater must be added to extend the
RS-485 network.

F.1. Basic RS-485 Network

The basic component of the RS-485 network consist of a Master Controller (or using a PC as a host

controller), and some RS-485 devices.

="

(I-7520 Series)
RS-232/ RS-485

Converter

WP-8000-CE7 Series User Manual, version 1.0.2 Page: 152

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com




F.2. Daisy Chain RS-485 Network

All RS-485 devices are wired directly to the main network, If the network is up to 1.2 km, it will

need a repeater (7510 series) to extend the network length.

R —

(1-7510 Series) (I-7510 Series)
(1-7520 Series) RS-485 Repeater RS-485 Repeater
RS-232/ RS-485

Converter

WP-8000-CE7 Series User Manual, version 1.0.2 Page: 153

Copyright © 2020 ICP DAS Co., Ltd. All Rights Reserved. E-mail: service@icpdas.com




F.3. Star Type RS-485 Network

There are branches along the main network. In this case, it is better to have a repeater to isolate or

filter the noise that is made by devices.

R —

(I-7520 Series)
RS-232/ RS-485

Converter
(I-7510 Series) (I-7510 Series) (I-7510 Series)
RS-485 Repeater

RS-485 Repeater RS-485 Repeater

g
K

-gm
K
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There is a better choice to use 7513 as a RS-485 hub on star type network.

S

(I-7520 Series)
RS-232/ RS-485
Converter

(I-7513 Series)
RS-485 Hub

I
J
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F.4. Random RS-485 Network

There are branches along the main wire. In this case, it is better to have a repeater to isolate or

filter the noise that is made by devices.

==t
(1-7510 Series)
(I-7520 Series) RS-485 Repeater
RS-232/ RS-485

Converter

(I-7510 Series)
RS-485 Repeater
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F.5. Master/Slaves Settings

The RS-485 network based on master-slave architecture consists of a single master device and one

or more slave devices.

The WiInPAC provides two RS-485 communication interfaces based on the master-slave system
architecture, all of which have a pull-high/pull-low resistor, user can set it to master or slave for

implementing an RS-485 multi-drop network.

One of the RS-485 communications, COM2, its pull-high/pull-low resistor located on power board,
the other, COM3, located on the right side and its pull-high/pull-low resistor located on the bottom

of the right side, as shown below.

Power Board

Master =— amm — Slave
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F.5.1. WinPAC acts as a Master (default)

When one of WInPAC is set to master, then all the other devices on the same network must be
slave mode. If the network is up to 1.2 KM, it will need a repeater (7510 series) to extend the

network length.

(I-7510 Series) (I-7510 Series)
RS-485 Repeater RS-485 Repeater

iSIav’ |el iSIav’ |el ISIav| |el iSIav’ |el
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When WinPAC as a master using COM2 communication interface, the pull-high/pull-low resistor

located on the power board must adjust to enable as shown below.

.C@‘M 2 Power Board

JP1: Pull-Low Enable
JP2: Pull-High Enable

When WinPAC as a master using COM3 communication interface, the pull-high/pull-low resistor

located on the power board must adjust to enable as shown below.

Master =— amm — Slave
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F.5.2. WinPAC acts as a Slave

For most of application, when using one 7520 series as RS-232/485 converter, its pull-high/pull-low
resistors are set to enabled. Then the WinPAC-8000 and all the other devices on this network must
be slave mode (the pull-high/pull-low resistors must be disabled).

If there are repeaters on the RS-485 network, there will be pull-high/pull-low resistors on both
sides of the repeaters (I-7510)

(I-7510 Series) (I-7510 Series)
(1-7520 Series) RS-485 Repeater RS-485 Repeater
RS-232/ RS-485

Converter

ISIav| |el iSIav’ |el

iSIav’ |el iSIav’ |el
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When WinPAC as a slave using COM2 communication interface, the pull-high/pull-low resistor

located on the power board must adjust to disabled as shown below.

COM?2 Power Board

\/

JP1: Pull-Low Disable
JP2: Pull-High Disable

When WinPAC as a slave using COM3 communication interface, the pull-high /pull-low resistor

located on the power board must set to “Slave” as shown below.

Master = mma —= Slave
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G. Revision History

This chapter provides revision history information to this document.

The table below shows the revision history.

Revision Release Date Description
1.0.0 June 2016 Initial issue
1.0.1 June 2016 1. Added the information about how to change the battery in
Appendix D.

2. Added the information about the 3G/4G applications in
Appendix E.
1.0.2 September 2020 | Added the appendix about RS-485 network in Appendix F.
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